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Chapter 1

Preface

TCfW Communication Server Client is a software program that allows you to communicate directly with
suppliers and partners with your method of choice: fax, email, voice, telex, X.400, Internet mail, SMS…

It also provides a universal access to important attachments. The FIS Folder gives you the opportunity to
attach centrally stored price lists, fact sheets, etc. and send them together with any outgoing message.

Furthermore, TCfW allows you to check whether your messages were successfully sent, scan documents
and send them as emails for example, save all the inbound and outbound message traffic in an Archive,
and much more.

All this functionality is right at your fingertips. No more switching around between programs and wasting
valuable time.
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Chapter 2

Getting Started

Ask the administrator in your company to install TCfW for you. (See the KCS Clients Administrator’s
Manual)

Logging In to TCfW
You must connect to the TCOSS server in order to use TCfW. To do so you need to log in with a User ID.

Unless the administrator in your company has set you up with Auto Login, the Login window shown
above appears each time you start TCfW. Enter your User ID and Password in this window.

Select Login from the Admin menu to change your password or the Auto Login option. You can do this
without affecting your current TCfW session.

Follow these steps to login to TCfW:

1. Start TCfW. The Login window shown above appears.
2. Enter your User ID and Password. (The administrator in your company is responsible for supplying

all users with passwords.)
3. Click OK.

Changing Your Password
1. In the Login window, enter your User ID and Password.
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2. Click the Change... button. The following window
appears.

3. Enter your password in the Old password field.
4. Enter your new password in the New password field.
5. Re-enter your new password in the Confirm new password field.
6. Click OK.

Bypassing the Login Procedure
Since the Login window does not appear at start up anymore, you have to access it by selecting Login in
the Admin menu.

1. In the Login window, enter your User ID and Password.
2. Check the Login automatically check box.
3. Click OK.

Automatic Login with Command Line Parameters
With TCfW it is possible to log in automatically with command line parameters. Separate parameter and
value by equals sign (=).

/USERID user id on the messaging server

/PASSWORD password

/MSGSERVERNAME name of the messaging server (e.g. DEMOTC)

/MSGSERVERPATH path of the messaging server (e.g. TCP/IP,DEMOTC)

/ARCSERVERNAME name of the archive server (e.g. TCARCHIVE)

/ARCSERVERPATH path of the archive server
(e.g. TCP/IP,TCARCHIVE:ARCHIVE)

/AUTOLOGIN auto login Y or N

/LANLOGIN LAN-login Y or N
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/LOCALDIR local path where toolbar settings are loaded/saved
(e.g. C:\TEMP)

/HELP this help window

Example:
C:\Program Files (x86)\TOPCALL\tcfw.exe /USERID="KCS Admin" /MSGSERVERNAME=MyKCS
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Chapter 3

The Main Window

The main window provides you with an intuitive desktop for easy access to a variety of objects such as
messages, Inbox, Outbox, folders, address books, system statistics, etc.

The toolbar and menu bar allow rapid access to commonly used menu functions.

The availability of menu and toolbar commands changes according to the features you are using.
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Message Menu

New
The New command allows you to create a new message with the default user template. Another option to
access this command is by clicking the icon on the toolbar.

New Select Template
The New Select Template command allows you to select another template for a single message or
change the default template.

Open
Opens an existing message stored in a folder. When one or more messages are selected in a folder
window, these messages open. Otherwise the Open Message window opens. Here you can select the
messages you want to open.
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Close
This command closes a message.

Send
This command initiates sending. This is similar to mailing a letter. Send places the message in the
TCOSS server. An entry is created in the Outbox for each recipient specified in the message header of
each message.

Save
The Save command allows you to permanently store the current message in a folder on the Kofax
Communication Server. If the message has never been saved before, only Save As is available.

Save As
The Save As command allows you to permanently store a message in a folder on the Kofax
Communication Server.

Note Depending on your user rights your available folders, where you can store messages, could be
different to the screen shot.

The following options are available in the Save As window:
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Message Name
Enter a name for the message. You can also copy and paste a name in the Message Name field.
Maximum length for a message name is 12 characters.

Save as Cover Sheet
Activate this to store your message as a cover sheet. Cover sheets automatically have the extension
CVR.

Note Merge values work only in cover sheets.

Default Template
When you click the New button, the default template is used. To change templates, you have to select
New Select Template from the Message menu to open the Select Template window. Any document you
select from here is used as a template for all subsequent messages until you change the default again.
The caption “Untitled” appears at the top of the message. (See also Using Default Templates.)

Message List
This contains a list of messages. Double-click an entry in this list to select it and close the window. Click
an entry once to display information about the file or message in the fields above the list.

Save Attachment As
This command saves a selected attachment in a directory. After you have specified a file name and the
directory where you want to save the attachment, select an output format in the ‘Save as type’ drop down
list. This works only with binary, image and text attachments, but not with messages attached from folders
on the Kofax Communication Server.
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Save as Type: Drop Down List
The drop down list specifies the output format for the attachment.
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Image attachments (TCI)
If you select an image attachment (TCI format) and then call up the Save Attachment As window, the list
offers following conversion choices:
• BMP - *.bmp (bitmap files)
• TIFFG32 - *.tif (TIF G3 type 2 files)
• TIFFG33 - *.tif(TIF G3 type 3 files)
• TIFFG4 - *.tif (TIF G4 files)
• TIFFU - *.tif (TIF unpacked files)
• TIFFP - *.tif (TIF packed file)
• PCX - *.pcx (PCX files)
• DCX - *.dcx (DCX files)
• TCI - *.tci (TC Image Format)
• MODCA1 - *.mda (MODCA with resource group)
• MODCA2 - *.mda (MODCA without resource group)

Text
If you select text and then call up the Save Attachment As window, the list will offer two conversion
choices:
• DOS Text
• Windows Text

Binary Attachments
If you select a binary attachment and then call up the Save Attachment As window, the list will offer no
choice for conversion.

Saving an Attachment with the Message Context Menu
1. Select an attachment in the message by clicking on it with the right mouse button.
2. A context menu opens, where you can select the format for saving the attachment.

Note The possible formats depend on the type of the attachment.
• Binary files cannot be converted into any other format.
• TC images can be converted in several graphic formats.
• Text blocks can be converted either in Windows or DOS text files.

3. After selecting the format a system defined window opens where you specify a file name and a folder
name for saving.

Reply
This command answers a received message. The To and From fields are swapped and the old header is
copied to the message area of the message window. You can add your comments and click Send. This
feature does not always work with incoming faxes because the sender info concerning incoming faxes is
unreliable.
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Replying to a message in Inbox terminates the message.

Forward
This command sends a copy of an open or selected message to one or more recipients. The original
header is moved to the beginning of the message text, allowing you to re-address the message and add
comments.

Forwarding a message in Inbox terminates the message.

Reject
If you have authorization rights you can reject a message sent to you for authorization. Simply select
Reject from the Message menu or click the icon on the toolbar. RJ: appears in the Subject field of the
authorizers’ message window. The senders’ address appears in the To field, and the original message can
be read in the message area, along with an additional text box. You can include your reasons for rejection
and click Send. The sender receives the original message along with your reasons for rejecting it. The
sender can then edit this message and send it again. (See Authorizing Message)

Reroute
With this command you can reroute messages in the Outbox or Inbox.

Resubmit
This command resends a message with a specified time delay. This command is available for new and
read messages. It is not available for terminated messages.

Resubmitting a message in Inbox terminates the message.

Mark Completed
Marks a selected message in the Inbox as completed. Marking messages as completed after having read,
printed or saved them keeps space on the Kofax Communication Server available for new messages.
Messages that have been marked completed are kept on the Kofax Communication Server as long as
possible to allow convenient access. However, such messages will eventually be deleted automatically or
moved to the Archive if your company has one installed (the time marked completed messages remain on
the Kofax Communication Server depends on the Server’s storage capacity and message traffic). But you
can store messages indefinitely in your personal user folders.

Authorize
Sends a message requiring authorization to its ultimate recipient or routes the message to the next
authorizer.

Delete
Deletes a selected message from your Message Folder or personal user folders. (The DELETE key on
the keyboard does not work here.)
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Correct
With this command you can correct the delivery address of a message in the Outbox.

Reactivate
This command reactivates a message from the Outbox. It is needed when there were delivery problems
(such as a broken network connection), that were solved in the meantime. The message is sent again

Set Priority
With this command you can change the priority of a job request.

Print
This command allows you to print the current message to a selected printer. (See the KCS Clients
Administrator’s Manual.)

Printer Setup
This command is used to select the printer and print options. (See the KCS Clients Administrator’s
Manual.)

Exit
This command closes the application. There is a possibility to cancel the closing process if there are
messages waiting to be sent.

Edit Menu
The Edit menu contains features for message layout.
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Delete
This command is used to remove a selected page or attachment from a message. You can also remove a
text box from a message, including all of its contents, by placing the cursor in the text box and clicking the
Delete icon on the toolbar.

Edit Page
This function depends on the kind of object selected.
• If an image page is selected: Converts the selected attachment to the format specified in the

configuration and starts the application associated with the extension of the file name. If the standard
configuration is used, the graphic format is bitmap and the associated extension is .BMP. Which
application is linked to this extension is defined within Windows. In a standard Windows installation
for example, Paintbrush is linked to the .BMP extension. In other words, in most KCS systems, the
selected image page is converted to bitmap format and Paintbrush starts.

• If an imported file is selected: TCfW starts the application, that matches the file’s extension, provided
the type of object chosen is linked to an application and the application is available on the workstation.

• If an attached message is selected: TCfW opens the selected message.

Overlay
This command is used to define an image block as an overlay. Overlays are images superimposed on
specified pages. Use the Overlay submenu to define the pages on which you want the overlay to appear.
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Note Overlays only work properly in cover sheets.

The Overlay submenu contains the following options:
• On This Page Only
• On Next Page Only
• From This Page On
• From Next Page On
• No Overlay

Insert Form Feed
Inserts a form feed (page break) after the cursor position within the message area, or at the end of the
message if the cursor is not in the message area. Each form feed determines the page format for all
pages that follow until the next form feed.

Insert Text
This command inserts a text box at the cursor position within the message area. Use this to insert text
between attachments.

Insert Signature Mark
This command inserts a placeholder for a signature at the cursor position within the message area. You
can choose between two types of signature marks; one can hold a signature from only one specific user,
the other from any user.

Insert Test Key Mark
This command inserts a placeholder for a test key at the cursor position within the message area. (See
Inserting Test Keys)

Page Format
This command is used to select page orientation and size. In order to access the Page Format submenu,
your message must contain a form feed. If it doesn’t, insert one with Insert Form Feed from the Edit
menu. Any text you type following the form feed will have that form feed’s page format.

You can choose from the following page formats:
• A4 Portrait
• A4 Landscape
• Letter Portrait
• Letter Landscape
• Telex
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Mark As Read/Unread
With this command selected messages in the folder view can be marked as read / unread.

Memo
This command is used to add Memo to the messages in Inbox and Outbox fields. This memo text can be
used to include additional information about a message.

If there is an existing short term archive entry for a mail entry, the memo is updated in the mail entry as
well as in the corresponding short term archive entry. This ensures that the updated memo is available in
short term archive entry even when the corresponding mail entry is deleted

Note Adding or updating memo text does not update the received/send time in TCfW. Therefore, the
order of received mails in inbox is not changed by any memo update.

View Menu
Use this menu to manipulate the display of your message.

23



Kofax Communication Server TCfW Communication Server Client User Manual

Text/Image Mode
This command toggles between Text Mode and Image Mode.
• Text Mode displays the message as text and the attachments as attachment lines only. You can edit

text in this mode.
• Image Mode displays the message as it looks when the recipient gets it, including its resolved cover

sheet and overlays. Zoom In, Zoom Out, Rotate, Flip, Optimize and Full Page allow you to manipulate
the display of your message in Image Mode.

Zoom In
This command enlarges the display.

Zoom Out
This command reduces the display.

Rotate
This command turns the page 90 degrees clockwise.

Flip
This command flips the page 180 degrees.

Optimize
This command removes the margins from your display. Zoom factor: page width.

Full Page
This command shrinks the page to fit into your window.

Toolbar
This command allows you to customize the toolbar. It is not possible to customize the toolbar on Japanese
operating systems.

Status Bar
This command shows/hides the bar at the bottom of the main window. Each time you click a toolbar button
a brief description of that button appears in the Status Bar. Click to toggle the display of the Status Bar.

In TCfW folders, the Status Bar displays the count of currently fetched items along with the number of
items selected in the folder. This is applicable for Inbox, Outbox, System Folder, FIS Folder, Message
Folder and Log Entries.
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For Users Profiles and Address Books, Status Bar displays the total item count and selected item count.

Attach Menu
Attach is used to add objects such as files or documents to a message. You can add binary and image
attachments of the same file to your message. Fax recipients receive only the image and local users get
both attachments. Local users can view and print the image component of the message received whether
or not they have the application in which the attachment was originally created.

You can add attachments to any message. They can be overlays, images, binary files or messages.

Scan
This command attaches paper-based documents (hardcopy) to your message. You can scan documents
with either a scanner or a fax machine. (See Attaching Hardcopy Documents by Scanning.)

Use your fax machine to send the fax to the number 88 followed by your access number and your access
password. If your access number is 45 and your access password is 81 you would send the fax to the
number: 884581.

If you don’t know your access number and password ask the administrator or check the Manual Fax area
in your User Profile in the Admin menu.

Message
This command attaches messages from a specified folder on the Kofax Communication Server to your
message.
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File
This command attaches various types of files to your messages.

When you open the Attach File To window, select a Directory, and then double-click a file entry from the
list. The Attach window appears.

In this window you can convert certain kinds of files to be attached into fax format and/or leave them in
their original file format. Text files, on the other hand, can be attached as text and/or as text files.
• Comment: The contents of this optional field is displayed in the attachment line to help you identify

your attachments.
• As Fax: This check box appears instead of As Text when you attach a file that TCfW can convert

internally into a fax image. TCfW recognizes monochrome images in certain formats and converts them
during attaching without assistance from other programs.

(For a list of supported file formats see Save Attachment As.)
• As Text: This check box appears in the window when you select a text file to attach. You can insert it

directly in a text box in the message area as text, and/or as a file attachment. When attaching text files
as text, you can choose between DOS Text and Windows Text in the drop-down list.

• As File: For internal sending only. The file is attached as it is. The recipient can open it if he/she has
the proper application installed in Windows. In any case, the recipient can use Save Attachment As
from the Message menu to retrieve it from the received message.)

Sign
Searches the open message from the current cursor position down for the next empty signature
placeholder and calls up the Sign window. Select this function in Image Mode to view your signature. You
can insert your signature only once per page. (See Inserting Signatures with WinWord)
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Archive Menu

Demo
If you do not have an archive server installed, you can see what it would look like in this window.

Admin Menu
Most of the Admin menu commands are available only to users with administrator status. They are
explained in detail in the KCS Clients Administrator’s Manual.

Address Book
Allows you to add new recipients and distribution lists to address books and edit existing ones. (See
Recipient Window)

Information about creating or editing distribution lists can be found in the KCS Clients Administrator’s
Manual

User Profiles
Maintains user profiles that determine the rights and restrictions of each user. (See the KCS Clients
Administrator’s Manual.)
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Proxy Address View
To open this window select User Profiles in the Admin menu and select Address View from the drop
down list. Proxy addresses are the combination of all active and inactive addresses specified for a user.
The ability to list users by proxy address simplifies administration of DID numbers by providing one
overview of all assigned numbers. The view allows filtering on service and address, allowing only a
specific set of users to be listed.

As a User Profile may contain multiple addresses, multiple entries in the Address View list may point to
the same user profile.

An entry opened from Address View shows the address properties by default. After editing the addresses
of a user, the list view must be refreshed manually to reflect the changes. The Address View provides full
filtering on all columns except Active. The Delete and New buttons are not available in this view.

Services
This allows the administrator to maintain a service directory for all of the communication services
supported by Kofax Communication Server. (See the KCS Clients Administrator’s Manual for more
information about the Services window.)

Login
Open this window to change your password, or to activate the Auto Login feature.
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Change Password
Allows you to change your own password. This resets the validity period.

Note To change your own password you must have the right to change your password set in your user
profile. Ask the administrator in your company about this.

Server
This submenu provides the administrator with a number of tools for managing and monitoring the Kofax
Communication Server. (For a detailed description of each of the Server submenu functions, see the KCS
Clients Administrator’s Manual.)

Start and Stop Distribution
Toggles distribution mode on and off. For distributing incoming messages addressed centrally, rather than
to individual recipients. This is only available to users with Distributor Status set in their profiles. (See the
KCS Clients Administrator’s Manual for more information.)

Preferences
The command Preferences in the Admin menu allows you to modify the most common application
settings. It is only accessible, if the right is set within the user profile. It is recommended not to make
any changes in here unless you are a more experienced user and know what settings to use. (See TC
Preferences)

Folder Menu
Folders are used to file messages logically. Each user has one Message Folder on the Kofax
Communication Server and can create additional folders in the PC environment.
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Create Folder
Creates a new folder located in a DOS directory. You have to specify the folder name and path in the
Create/Add Folder window.

Delete Folder
Deletes a folder. You have to specify the folder name in the Delete Folder window. You cannot delete
folders on the Kofax Communication Server.

This command does not, however, delete the folder files stored in the Windows directory. You can restore
a deleted folder with Create/Add Folder by choosing the same directory since it is still displayed in the
list. Do not change the default folder name (Untitled). The folder appears once again at the bottom of your
Folder menu.

You can delete a folder permanently by deleting the folder files in the Windows directory and in the Delete
Folder window.

Copy Folder
Copies a folder to another location. It is used for backing up folders. (See  Copying Folders)

Export Fields
This function creates an ASCII file of a selected folder view (a folder view consists of a group of list entries
specified by a filter). The fields of the ASCII file are separated by TAB stops. The first line in the text file
contains the column header of the selected folder view. You can import this file later into MS-Word or MS-
Excel. (See Exporting Folder Views)

View Settings
Allows you to change the sequence of the columns here. (See View Settings Window)
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Set Filters
Allows you to set filters for your folders. Only the messages filtered are displayed.

Folder Window 1-4
You can open up to 4 folder windows from here. Each window can display any folder out of Inbox,
Outbox, Message Folder, FIS Folder, System Folder, and all of your personal user folders stored in
DOS directories. Select them in the tree view in the left pane of the folder window. Open folder windows
appear in the Folder menu with a check mark next to them.

Window Menu
The Window menu is used to manipulate the arrangement of windows on-screen. It also shows all open
windows.

Cascade
Arranges all open windows in an overlapping pattern.

Tile Horizontally
Arranges all open windows in a horizontal tile pattern.

Tile Vertically
Arranges all open windows in a vertical tile pattern.

Arrange Icons
Arranges icons of your open window at the bottom of the main window.

Refresh
Updates the contents of a selected window.

Any command lines in the Window menu below Refresh indicate open TCfW windows.
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Help Menu

Contents
Opens the Help window.

About
Shows product and copyright information.
In addition, the About window has a More button that displays system information when clicked.

Toolbar
The toolbar is a collection of shortcut buttons for fast access to menu commands. Only the toolbar buttons
that are available for the selected object are displayed. For a short description of any toolbar button,
place the cursor on the button and let it rest there. A small box appears after two seconds identifying the
button’s function.

Note You can disable and enable toolbars as well as configure your own by clicking in the toolbar area
with the right mouse button.

The toolbar buttons from left to right:

Main Toolbar
Creates a new message using the default template. Same as New from the Message menu.

Sends the message to all recipients specified in the Recipient list. It is used to finalize forwarding,
replying, distributing, and correcting. Same as Send from the Message menu.

Opens an existing message. If messages are selected in a Folder Window, these messages are
opened; otherwise an Open Message panel opens. Same as Open from the Message menu

Searches the Archive. It is only enabled when an archive folder is selected in a folder window. This
button opens the archive search panel.

To reply to a received message. Same as Reply from the Message menu.

To forward a received message. Same as Forward from the Message menu.
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To reject a message received for authorization. Same as Reject from the Message menu.

Select messages in the Outbox or Inbox and click the Reroute button to call up the Recipient dialog
in which you can specify a new delivery address.

To authorize a received message. Same as Authorize from the Message menu.

Gives the message the status of Marked completed and closes the message. Same as Mark
Completed from the Message menu.

Deletes a message from a personal user folder (or System Folder if you have sufficient rights). Use
Mark Completed instead to delete messages from the Inbox or the Outbox.

Click the Correct button to call up the Recipient window in which you can correct the delivery
address of a message in the Outbox.

This button reactivates a message from the Outbox. It is needed when there were delivery
problems (such as a broken network connection), that were solved in the meantime. The message is
sent again.

Refreshes the current display. Use this button if something has changed but hasn’t been updated
yet. It can be used, for example, to check if new message have arrived. The keyboard alternative is
F5.

Fetches all items from the server in the current folder. For example, clicking this button in Outbox
folder fetches all the messages in the Outbox folder. This is applicable for Inbox, Outbox, System
Folder, FIS Folder, Message Folder and Log Entries.
The Status Bar displays the count of fetched items and the number of selected items.

Prints the message. A printer panel opens.

Saves the message. Same as Save from the Message menu.

Checks an entered address. This works only if a message is opened. It selects either the recipient
specified in the recipient field of the message, or opens the selected address book.

Allows you to scan a document into your message. Similar to Scan from the Attach menu

To attach a file to your message. Same as File from the Attach menu.

To attach a message to your message. Same as Message from the Attach menu.

Signs a message. Your signature replaces the signature placeholder in the message. This button is
only available when your user profile contains a signature. Same as Sign from the Attach menu.

33



Kofax Communication Server TCfW Communication Server Client User Manual

Resends a message with a specified time delay. This command is available for new and read
messages. It is not available for terminated messages.

Adds or edits memo text for an Inbox or Outbox message. Same as Memo from the Edit menu.

Image View Bar
Toggles between Text Mode and Image Mode. Same as Text/Image Mode from the View menu.

Enlarges the display. Same as Zoom In from the View menu.

Reduces the display. Same as Zoom Out from the View menu.

Turns the display 90 degrees to the right. Same as Rotate from the View menu.

Turns the display 180 degrees to the right. Same as Flip from the View menu.

Removes margins from the display. Same as Optimize from the View menu. Zoom factor: page
width.

Restores margins to the display. Same as Full Page from the View  menu.

Distribution Bar
This bar is useful to distributors.

(See the KCS Clients Administrator’s Manual for more information on these buttons).

 Start Distribution.

 Stop Distribution.
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Chapter 4

Working with Messages

This section describes how to work with messages.

Message Window
The message window consists of a header area and a message area.

The header area contains recipient and sending information. The message area contains the actual
message that can include a cover sheet, text, and various kinds of attachments.

Since Kofax Communication Server supports a variety of sending services, two different displays of
messages are possible.
• Text Mode displays the whole message as text within the message area of the message window, while

displaying each attachment as one attachment line only. You create and edit messages in this mode.
• Image Mode displays the message in WYSIWYG (what you see is what you get) format, including the

resolved cover sheet.

Note You can select whether you want the message header to scroll with the message content when
scrolling a long message. Do this in the TC Management Console (Start menu/Kofax Communication
Server/TC Management Console). Select General Settings in the tree view and check the Scroll
message header with message content check box.
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Message Area in Text Mode
Text Mode displays the message as text while each attachment is displayed as an attachment line only.
You can edit your messages in this mode.

The example below shows the message area in Text Mode:

Incoming faxes do not contain attachments. Here is an example of a two-page incoming fax message
displayed in Text Mode:

Representation of alternative content

TCfW groups the attachments and corresponding alternative content together into one block that can then
be moved and copied like all existing message parts (text blocks, attachments and page separators).
Attachments containing alternatives can be edited via the edit function (the corresponding application is
started for editing). All alternatives are deleted automatically, if the original changes. It is not possible to
move or delete alternatives selectively.

Changing the Appearance of the Message Window
TCfW allows you to configure the looks of the message window yourself.

To do this open the TC Management Console (Start menu/Kofax Communication Server/TC
Management Console) and select Appearance in the tree view.
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Set the font and colors as you would like them.

Send Options Window
The Send Options area is the box at the top right of the message window (below the Address Book
drop-down list). Click anywhere in this area to call up the Send Options window shown below:
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Clicking the Change Cover button displays the cover list as shown below.
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Elements of the Send Options Window
To/Auth Priority.

Cc/bcc Priority

The Priority level can be one of the following values:

low, normal, high, high 1,high 2,high 3,high 4,high 5,high 6,high 7, high 8,high 9 or highest.

Note The priority levels high1 .. highest requires at least TCOSS 7.44.03

Delivery Notification drop-down list: Determines in which cases a (non-)delivery notification is given.
Delivery notification is defined in each User Profile. This list only allows you to deactivate and reactivate
these User Profile settings.

Set Date And Time For Sending check box and fields: Determines when the first delivery attempt should
take place. If the check box is not marked, the message is released immediately for sending.

Set Date And Time For Latest Delivery check box and fields: Allows you to enter the latest possible time
the message can be sent at. This is useful if you need to send a fax to someone by a certain time and is
pointless if it arrives after that time. If the check box is not marked, the latest delivery time is infinite.

Cost Center field. Allows you to define the cost center the message should be billed to.

Sending Copy drop-down list: If set to All, a copy of each outgoing fax message, even if the same
message is sent to multiple recipients, is printed during sending. If set to First, a copy of only the
message sent to the first recipient is printed. The User Profile defines where the sending copy is printed
or delivered.

Resolution drop-down list: For setting the fax resolution to either High or Normal. High is slower and
therefore more expensive, but produces a clearer fax image.

Fax Header Line check box: Used to activate the header line in faxes.

Cover field, and No Cover and Change Cover buttons: Used to select, modify or suppress cover sheets.
Click Change Cover to view the Cover Sheet list. All cover sheets in your Message Folder and in the FIS
Folder are listed. The name of your Message Folder in this list is the same as your User ID. Click any
entry in this list to copy it to the Cover field.

To find the required cover sheet, you can filter the cover list on the basis of a column.

Double-click on the blank cell above the respective column header and specify the filter criteria. You can
also add filters for multiple columns.

Note Folder Name field is not available for filtering.
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Filter name Description Additional information

File Name This filter is case sensitive.
"Gree", "Gr" will return "Greet", "Green", but will
not return "green" or "greet".

Subject This filter is not case sensitive
"greetings", "GreEtinGs", "GREETINGS" will all
return "greetings".

The * can be used as wildcard at the
beginning, end, or beginning and
end.
If the text string is not having * at its
end, the * is internally added at the
end of the string.

File Size Specify a valid file size range in the From and
To fields. All the messages within this range are
shown.

Created At Filter with date/time values have popup calendar
control, so the date and time can be entered
from this control. All the messages which have
been created during this interval are shown.

Registered message: a registered message stays open in the Outbox until the recipient opens the
message.

Ignore invalid recipients: If there’s an invalid recipient among the list of recipients, the message is
delivered to all but the invalid one. If this check box is not selected, the entire message is rejected and will
not reach any of the intended recipients.

Addressing Messages
Before sending a message, you need to define the header—recipients, content, and delivery type.

Since some recipients can be reached via different services (e.g., fax and telex), each can have several
addresses. Some of the addresses will work better and can therefore have a higher priority by placing
them at the top of the list. Kofax Communication Server always tries to send to the address at the top of
the list first.

In TCfW address books, each recipient has a list of alternative addresses. If neither the main address nor
the alternative addresses works Kofax Communication Server will notify you.

Header fields in the message window include the following:
• Delivery type drop-down list (also called the To field) at the left top. Possible options:
• To: These recipients are listed in the cover sheets of messages.
• cc: (carbon copy) cc recipients are listed in the cover sheet of messages.
• Bcc: (blind carbon copy) The sender sees bcc recipients in the Recipient list. Recipients, however,

only see To and cc recipients in the Recipient list because bcc recipients are not listed in the cover
sheet of messages. This feature is useful when you want to send a copy of a message to someone but
don’t want the other recipients to know that a copy was sent.

• Auth: This means that before a message can be sent, it first has to be authorized by someone. If a
message is sent for authorization to a user without authorization rights, this user can only reject the
message. Auth recipients are not listed in the cover sheets of messages.
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• Recipient field at the top, next to the Delivery type drop-down list lets you enter recipients or search
strings manually.

• Recipient list below the Recipient field contains all specified recipients.
• From field contains the sender.
• Subject field is an optional field to indicate the message content.

Using a cover sheet lets you include merge values in your messages. You can see how your final
message, including its cover sheet, will arrive by clicking the Text/Image toggle button on the toolbar.

You have to specify at least one recipient before you can send a message.

The From field contains the sender (i.e., you, the user). Only the Distributor, if he opened the message
in Distribution mode, can modify the From information by placing the cursor in the From field and clicking
ENTER. This allows the Distributor to enter a valid sender (the same way a recipient is entered) when
external messages such as faxes come in.

Click anywhere in the Send Options area (top right below the Address Book drop-down list) to open the
Send Options window in which you can set your send options.

Selecting Recipients from Address Books
Before you can select recipients from an address book do the following:

1. Click New from the Message menu to open a new message.
2. Select the address book you want from the Address Book drop-down list. Each user may access

the system address book, a group address book, and his/her own personal address book.
3. Place the cursor in the Recipient field and select a recipient in one of the following ways:

• Click the Find button.
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The Find Recipient dialog opens, where you can search the address book with filter values. You
can use wildcards in the filter values. The search in the address book is case insensitive. Filter
values are always AND combined. A filter value may be either:

Option

abcd filters for exact value

abcd* string has to start with abcd

*abcd string must end with abcd

*abcd* abcd must be found in string at any place

• Place the cursor in the Recipient field and press the ENTER key. The Recipient window opens.
You can enter and store a new recipient here.
(Refer to Recipient  for information on entering and storing new recipients.)
After you enter and save the recipient information, click Select to copy this entry to the Recipient
list and return to the message window. You can edit a recipient address already copied to the
Recipient list by double-clicking it. You can delete recipients from the Recipient list by selecting
one at a time and pressing the DELETE key.
If the recipient has a short name, the entry copied to the Recipient list will contain short name, full
name and the recipient's active services. If the recipient doesn't have a short name, you will see
full name, first active service and number:
SM, Markus Schmid, FAX, Telex
or
Markus Schmid, FAX, 66133839

• Place the cursor in the empty Recipient field and click the Check Address button on the
toolbar. The Address Book window opens. Select a recipient from the list to copy him/her to the
Recipient list.

Note Pressing ENTER with the cursor in the empty Recipient field, on the other hand, opens the
Recipient window.

• Enter the beginning of a recipient’s name for instance. Press ENTER. If the string or character
in the Recipient field doesn't match a stored recipient's short name, the selected address book
opens at the closest match. For example, if you enter the following:
L↵
The address book opens at the first L entry.
Note: The Check Address button on the toolbar and the ENTER key have the same effect when
the Recipient field is not empty.

• Enter a string for the stored recipients’ short name of not more than eight characters or a number
of not more than four digits and press ENTER.
If the string entered matches the short name of an existing recipient, this recipient is selected from
the current address book and be copied to the Recipient list:
fz↵
FZ, Fred Zimmer, TC
or
034↵
034, A. Costa, FAX, X400
If the string does not match an existing recipient, the address book opens at the closest matching
entry. The short name may not contain blanks or commas.
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Addressing Recipients Manually
You can address recipients not contained in an address book in one of the following 4 ways:
• Enter the service and number, and press ENTER. The entry is copied to the Recipient list provided you

enter it correctly:
Fax: 6613321
FAX, 6613321

If the syntax of this entry is incorrect or incomplete, the Recipient window appears.
• Enter a number longer than 4 digits and press ENTER.

This copies the entry to the Recipient list with the default service Fax.
66133834

FAX, 66133834
• In the Recipient field enter: full name, service, number.

Example: Markus Schmid, FAX: 66133839
Press ENTER and TCfW will check the syntax of the address. Syntax errors open the Recipient
window. Make the necessary changes. If the syntax is correct, the selected recipient appears in the
Recipient list.

• Enter name and number and press ENTER.
As above but with the default service FAX inserted:
John Smith, 66133834
John Smith, FAX: 66133834

Changing Sender
You can send your messages under any other sender if you have the right Change Sender configured.

Follow these steps to change the sender:
1. Click into the From field and press the ENTER key.
2. Change the sender information.
3. Remember to click the Save Addr button if you want to change any addresses, otherwise the

changes will not be stored.
4. Click the Select button to confirm the changes.

Note
• After sending the message, it is displayed in the new sender’s Outbox.
• If any events are defined in the user profile of the new sender, they are used.
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Sending Fax Messages
When sending messages an entry will automatically be created in the Outbox for every recipient of the
message. Follow these steps to send a fax message:

1. Select New from the Message menu or click the Send icon on the toolbar to create a new message.
2. Click the To drop-down list to select delivery type—either To, cc, bcc or Auth.
3. Fill in the Recipient field (on the right of the To field) with the recipient’s name, the sending service,

number (e.g., John Miller, FAX, 215 666 1234).
4. Press ENTER. 

Repeat these steps as often as needed to send the message to various recipients with different
delivery types.

a. Fill in the Subject field (optional).

b. If a text box is not already open, select Insert Text from the Edit menu to insert it. (See
Entering Text)

c. Type your message in the message area (lower half of the message window).

d. Select Send from the Message menu or click the Send icon on the toolbar.

Note A message cannot contain more than 30000 recipients.

Entering Text
In the message area of the message window—below the Subject field—there is a text box in which you
can type your message. This area supports such editing features as Cut and Paste.

Normally a text box is inserted automatically when opening a new message. Should this not be the case,
insert the text box doing the following:

1. Open a new message by selecting New from the Message menu or clicking the corresponding icon
on the toolbar.

2. Select Insert Text from the Edit menu. A text box appears in the message area.
3. Place the cursor inside the text box and type your message.

Delete text box
To delete a text box with its contents, follow these steps:

1. Position the cursor inside the text box you want to delete.
2. Select Delete from the Edit menu. (The DELETE key will not work here.)

Status of Outgoing Messages
TCfW allows you to see the status of all your outgoing messages in the Outbox. A separate entry is
generated for each recipient.

The status of the messages is shown with the following icons:
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Status Meaning

 Waiting No send attempts have been made yet. When sending internally this
status means that the message has not been touched (viewed, printed,
copied) yet.

 Active Sending in progress. At least one sending attempt was made. When
sending internally this status means that the message was touched.

 Sending Sending in progress. When sending internally this status does not exist.

 Active — Forwarded Sending in progress and message routed to next node. When sending
internally this status does not exist.

 Inactive — Problems Message marked completed due to a send error. This status is shown
when the TCOSS server finished all send retries and could not send the
message successfully. User intervention is necessary to cancel, correct
or reactivate the message. Cancel Mess. leads to the status Cancelled.
Correct and Reactivate lead to either the Waiting or Sending status.
When sending internally this status does not exist.

 Sent OK Message was delivered successfully.

 Sent OK—Log Entry Message was delivered successfully. Only the log entry exists; the
message itself has been deleted.

 Cancelled Message was cancelled by the user.

 Cancelled—Log Entry Message was cancelled by the user. Only the log entry exists; the
message itself has been deleted.

 Send Attempt A logged send attempt from the short-term archive. This means e.g. for
a fax line that all cases where the distant subscriber was busy or not
reachable for some other reason are now documented in the short term
archive.

To check the status of your outgoing messages do the following:
1. Open a folder window from the Folder menu.
2. Open the Outbox in the Folder window.
3. Scroll to the entry you want.

You can search for messages by setting a filter. Click any column header on the right pane and
select Set Filters from the menu that appears. (See Elements of Folder Windows)
Correct, cancel or reactivate the message if necessary by clicking the corresponding icon in the
toolbar or selecting the corresponding command in the Message menu.

Sending Non-Fax Messages
Kofax Communication Server offers more than just fax.

With the right configuration, you can exchange messages with services other than fax. And with the right
equipment, you can exchange messages with internal email users, telex subscribers, mainframe users
and others.
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You can define the sending service when you address a message. Kofax Communication Server contains
a directory of all services available to you.

Other Services Supported by Kofax Communication Server
Depending on your system's configuration, you can send and receive messages to or from a variety of
services. These services can be either public or internal.

Among others Kofax Communication Server offers links to:
• Fax (including Fax over IP)
• Voice (including Voice over IP)
• SMS
• SMTP
• Telex
• Scanner
• Multi-functional Peripherals (MFP)
• SOAP
• XML
• File interface
• TC/Broadcast
• IBM MQ Series
• SAP
• Lotus Notes
• Microsoft Exchange

Note Internal messages can be sent to other TCfW users through the local service.

Receiving Messages
Incoming messages are stored in your Inbox. Kofax Communication Server can be configured to notify
you whenever a message arrives. There are several methods of notification, depending on the settings
in your User Profile (e.g., your phone rings twice, a broadcast message appears on your screen, your
beeper beeps). You may also have your incoming messages automatically printed on a printer or fax
machine. (For further information see the Server Package manuals.)

Accessing your messages:
1. Open a folder window from the Folder menu.
2. Select Inbox from the Folder window.
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3. Double-click the message you want to open.
You can select the Text/Image command in the View menu or click the corresponding icon on the
toolbar to toggle between Text and Image Mode.

Note You can select multiple messages in a folder window by using SHIFT-CLICK and CTRL-
CLICK. Open them by selecting Open from the Message menu or clicking the icon in the toolbar.

You can do the following with an opened message:
• Print the message out on your default printer. (To define another printer, select Printer Setup or

Printer from the Message menu.).
• Select Save As from the Message menu to store the message in another folder.
• Mark the message as completed by selecting Mark completed from the Message menu, or by

clicking the corresponding icon on the toolbar.

Opening a attached file
Opening a file attached to an incoming message:

1. Set the opened message to Text Mode by selecting Text/Image from the View menu or clicking the
corresponding icon on the toolbar.

2. Click the attachment line.
3. Select Edit Page from the Edit menu. This will automatically run the application the file was created in

(e.g., WinWord), provided this application is installed on your PC or workstation.
4. Read, edit and save the file as you want.

Note You may also click Save Attachment As from the Message menu in TCfW, once you have
highlighted a file attachment line. This allows you to place the attached file somewhere in the file
system.

Important: Don't forget to mark your messages as completed. This helps free space on Kofax
Communication Server for new messages. Messages that have been marked completed are stored
on Kofax Communication Server for as long as possible for convenient access. However, such
messages will eventually be deleted automatically to make room for new ones. (The duration such
messages are kept depends on the TCOSS server's capacity and message traffic.). You can store
messages indefinitely in your personal user folders or in the Kofax Communication Server Archive if
there is one available.

Replying to Messages
When replying to a message, the contents of the To and From fields are swapped and the old header
along with the original message is copied to the message area of the message window.

Note When you reply to a message sent to multiple recipients, your reply is sent to each of these
recipients.

Follow these steps to reply to a message:
1. Select Open from the Message menu to open a specific message, or select the Inbox in a Folder

window and double-click the message you want to reply to.
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2. Select Reply from the Message menu. Two text boxes open in the message area. One contains the
message header. The second contains the message you are replying to.

3. Modify the header and/or the message as needed.
4. Delete recipients from the recipient list in the message window by selecting them and pressing the

DELETE key on your keyboard.
5. Write your reply in the second text box or open a new text box.
6. Select Send from the Message menu.

Forwarding Messages
Forwarding is used to send a copy of a received message to other recipients. The original header is
moved to the beginning of the message area, to allow you to re-address the message and add comments.

Follow these steps to forward a message:
1. Open the message by double-clicking its entry in the Inbox list.
2. Select Forward from the Message menu.
3. Re-address your message.
4. Modify the message and add comments as needed.
5. Select Send from the Message menu.

Resubmitting Messages
Resubmitting is used to resend an already received message again with a time delay.

Follow these steps to resubmit a message:
1. Open the message from the inbox by double-clicking its entry in the Inbox list.
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2. Click the Message menu and then click Resubmit. A new window
opens

3. Select either date and time or a period for resubmitting
4. Click the Resubmit button to resubmit the message.

Text and Image Modes
Since Kofax Communication Server supports a variety of sending services, you may view your messages
in Text Mode or Image Mode.

Text Mode displays the whole message as text while displaying each attachment as an attachment line. In
this mode you can edit the text of your message.

Image Mode displays the message in WYSIWYG (what you see is what you get) format, including the
completed cover sheet. You may add text annotations or paste images here.

To toggle between Text Mode and Image Mode one of the following:
• Select the Text/Image command from the View menu
• Click the Text/Image icon on the toolbar.

50



Kofax Communication Server TCfW Communication Server Client User Manual

Switching Font and Code Page in Text Blocks
The menu Edit provides the sub menu Text Font. This menu is enabled if the cursor is in a text block
within a message. The current selected font is checked.

Font: text blocks are treated as TC Code Page 0 or Code Page 1, depending on the configuration. Within
TCfW the font Courier New is used for display.

Note If TCfW is configured for Unicode the sub menu Text Font is disabled. The font that is configured
for the message content is used.

Form Feeds and Page Formats
In TCfW, each form feed contains the page format for all the pages of a message that follow. The most
common type of form feed contains the A4 page, used for faxes. TCfW also has form feeds for the
page formats A4 Landscape, Letter, Letter Landscape and Telex. Your default template, which is used
each time you select New from the Message menu, should contain a form feed at the beginning of the
message. Form feeds appear within the TCfW message area, in text format, as dotted lines with the page
format defined in the middle.

Inserting a Form Feed in a Message
Follow these steps to insert a form feed into a message:

1. Make sure you are in Text Mode and that a message is open in the message window.
2. Place the cursor in a text box or select any reference line to insert a form feed directly after this text

box or line. If the cursor is not in the message area when you insert a form feed, the form feed is
placed at the end of the message.

3. Select Insert Form Feed from the Edit menu. In Text mode, each form feed is displayed as a dotted
line with a page format in the middle.

Deleting a Form Feed
1. Select the form feed with a single click.
2. Press the DELETE key.
3. Select a page format
4. Highlight the form feed (page boundary) you want to format by clicking it.
5. Select Page Format from the Edit menu.
6. Choose the desired page format from the Page Format submenu. The name of the page format

appears in the middle of the form feed in the message area.
7. Switch to Image Mode to see how your new page format will look.
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Attaching a Printout
You can add various types of files to your messages from any application by "printing" them to the TC Fax
or TC Telex from within Windows applications. If no TCfW message is currently open this procedure will
automatically start TCfW and open a new message and attach the printout.

Attaching Hardcopy Documents by Scanning

Scanner
You can insert paper-based documents (hardcopy) into a message by scanning them in. You can either
scan in the hardcopy documents with a scanner connected to your workstation, or by using the nearest
fax machine as a scanner.

Follow these steps to scan documents with a scanner:
1. Make sure your scanner has been set up to work with TCfW.
2. Click Scan from the Attach menu. The Scan Into window opens.
3. Enter a comment in the Comment field (optional).
4. Select Start next to Scan With Scanner. The Scan Into window opens.
5. Enter a short description of the scanner software in the Title field (optional).
6. Enter the DOS path and .EXE file of the program that executes the scanner software in the Program

field.
7. Enter the DOS path and file name in which you want your scanned document stored in the Output

File field.
8. Click OK.

Follow the required procedures on your scanner to scan the document into your message. The
scanned document will automatically appear as an attachment in your message.
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Fax Machine
Follow these steps to scan a document with a fax machine:

1. Select Scan from the Attach menu.
2. Enter a comment in the Comment field (optional).
3. Select Start next to Scan With Fax.
4. Write down the number displayed in the Scan Into window.
5. From a fax machine, send the document to this number.

The scanned document will automatically appear as an attachment to your message.

Use your fax machine to send the fax to the number 88 followed by your access number and your access
password. If your access number is 45 and your access password is 81 you would send the fax to the
number: 884581.

If you don’t know your access number and password ask the administrator or check the Manual Fax area
in your User Profile in the Admin menu.
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Attaching Files
You can use this feature to add objects such as binary files or images to a message. With certain kinds of
files, you can attach both binary and image attachments of the same file to your message. Fax recipients
get only the image and local users get both attachments. Local users can view and print the image
component of the message received even if they don't have the application in which the message was
created.

Follow these steps to attach a file:
1. Select File from the Attach menu.
2. The Attach File To Message window opens, where you can select the file that you want to attach

to the message. If you want to attach multiple files hold down the CTRL key while selecting the file
names with the mouse. After you have selected the files click the OK button. A single file can be
selected by double-clicking it.
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3. The Attach window opens for each selected file and you can select how to attach the file. The
possible formats depend on the content of the file (e.g. a text file can be attached as text or as file).
To attach the file click the OK button.

You can attach some files As File, As Fax, or both. With text files the choice As Text appears
instead of As Fax. If you select a message from a folder, you will bypass the Attach window
completely and the message is attached.

Note If Unicode is not enabled on your KCS, you can only attach Unicode text to your message as
a file.

Attaching Files with Drag & Drop

How to Attach Files from the Windows Explorer with Drag & Drop
1. Open Windows Explorer.

Note To open Windows Explorer, click Start, point to Programs, point to Accessories, and then click
Windows Explorer

2. Find the file(s) that you want to attach.
3. Drag the file to the message body of the TCfW message.

Definition of drag: To move an item on the screen by selecting the item and then clicking and
holding down the mouse button while moving the mouse.

4. The Attach window opens for each file and you can select how to attach the file.
The possible formats depend on the content of the file (e.g. a text file can be attached As text or As
file). To attach the file click the OK button.
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How to Detach Files from the Message Window to the Windows Explorer
with Drag & Drop

1. Open Windows Explorer.

Note To open Windows Explorer, click Start, point to Programs, point to Accessories, and then click
Windows Explorer

2. Find the folder where you want to detach the attachment.
3. Hold down the SHIFT key and drag the attachment to the folder in the Windows Explorer Window.

Note You must press and hold down the SHIFT key before you start the drag operation to the
Windows Explorer.
If an attachment has no file name (e.g. an image with alternate content) you cannot detach it with
Drag & Drop.

Attaching Messages
You can use this feature to add a message from any folder to a message.

1. Select Message from the Attach menu. The Attach File To Message window opens.
2. Specify the Kofax Communication Server folder in which the message is located
3. Double-click the message from the list
4. The selected message is attached to the message

Editing Attachments
You can view and edit your attachments by selecting their corresponding attachment lines in the
message area in Text Mode and selecting Edit Page in the Edit menu. The related application will start
up automatically if it's available and installed properly. When you select a fax attachment, for example,
Paintbrush (or any other application linked in the File Manager to the extension .BMP) is started for
editing.

To edit an attachment follow these steps:
1. In Text Mode, select the attachment you want to edit by clicking its attachment line once.
2. Select Edit Page from the Edit menu. The application in which the attachment was created is

launched making the attachment visible. (This application may be TCfW, in which case a second
message window opens over the first.)

3. Make your changes and save them.
4. Exit the application.

You will return to the TCfW message window.
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Editing in Image Mode
The Image Mode allows to add annotations to images (=received faxes). You can also mark an area of an
image and cut or copy it, and paste it into another image. You can view and edit your messages in either
Text or Image Mode. Select Text/Image Mode from the View menu or click the corresponding icon on
the toolbar to switch modes. Images, like an incoming fax, can only be edited in image mode, text parts,
usually used in internal messages, can only be edited in text mode.

Editable Objects
Only embedded image objects are editable. Text objects and overlays cannot be edited. If a page contains
editable and non-editable objects then the non-editable parts of the page are marked gray when the page
is changed (by pasting text or image or by inserting a new annotation).

TCfW example of a two page inbound fax:

The objects with the attribute ‘Image’ can be changed.

TCfW example of an outbound fax containing attached messages:

Attached messages (whether reference line or embedded) must be opened by double-clicking them
before they can be changed.
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Frame Properties
A frame is a field for text or image. It has the following properties:
• A frame can hold either text or image
• You can move and resize the frame by selecting it.
• You can enter text directly into the selected text frame
• You can create a new text frame by selecting New Annotation from the shortcut menu or by pasting

text onto an image page if no other frame is selected.
• Pasting an image from the Clipboard creates a new image frame.
• Cutting or deleting a selected area creates a white frame.

Possible actions on a selected frame:
• Move via mouse
• Resize via mouse
• Delete via keyboard (bitmap only)
• The right mouse button shows a shortcut menu.
• Paste text from the Clipboard into the frame.

Frame Shortcut Menu (Right Mouse Button)
When you click the right mouse button this menu appears:

The shortcut menu is used for the following actions:

New Annotation Inserts a new text frame.

Cut Copies the current frame or selected area to the Clipboard. If an area is selected
then the area is overlaid with a new white frame. This option is only available when
the page is editable.

Copy Copies the frame contents (text or bitmap) to the Clipboard.

Paste Inserts a new text or image frame containing the text or image from the Clipboard
or adds a text from the Clipboard to the selected text frame.

Delete Deletes the selected frame or selected area. If an area is selected then the area
is overlaid with a new white frame. This option is only available when the page is
editable.
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Inserting Text Annotation
To insert a text annotation, do the following:

1. Select New Annotation from the shortcut. This option is only available if the page is editable. An
empty frame appears in the top left corner of the image.

2. Move and size the frame with the mouse as necessary.
3. Insert text into the frame.
4. Set the properties for the text frame as needed by clicking the right mouse button and selecting the

Properties entry.

Copying or Cutting a Selected Frame or a Selected Area
If you selected Cut an empty frame will remain. You can restore the content by re-selecting the frame and
moving it again.

1. Click one corner of the area you would like to cut or copy.
2. Hold the mouse button down while dragging the mouse.
3. Once the frame surrounds the desired area release the mouse button.
4. Select Cut or Copy from the shortcut menu. Cut is only available if the shown page is editable.
5. Paste the cut or copied frame in the desired position.

Pasting Text or Image onto the Page
Note A bitmap is always converted to a monochrome bitmap before it is pasted.

1. Choose Paste from the shortcut menu. Paste is only available if the page shown is editable and if
either text or image is available on the Clipboard. The pasted text or image is copied to a new frame,
which appears in the top left corner of the image.

2. Position and size the frame as necessary.

Properties Dialog (Text Frame Only)
When you select Properties from the shortcut menu a window showing the annotation properties opens.
Properties are only available on the shortcut menu when the current frame is a text frame. Frames
containing image do not have additional properties.
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You can set the following properties:
• Background: White, Transparent
• Border: Size in points
• Font Dialog: Face, Style, Size

Printing in TCfW
Select either Print or Printer Setup from the Message menu to change print settings before printing.
You can select a new printer, define number of copies, and specify a variety of other print options. Any
changes you make in either of these windows are only valid for your current TCfW session.

Click the Print icon on the toolbar.

Sending via Telex or Other Text-Based Services
Messages typed into the message area of the message window can be sent as pure text messages. If the
message contains binary or graphical attachments, these are not transmitted.

To help you send non-fax messages, KCS offers service-dependent templates, so even X.400 addressing
is easy. All you need to do is fill in these templates. (See Recipient )

Using Cover Sheets
A cover sheet is the first page of a message. It generally contains an overlay, such as your company logo,
and merge values, which allow you to insert specific codes that are then replaced with the corresponding
values when sent. If your cover sheet in TCfW contains the string
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$Name$

this merge value is replaced with the full name of the recipient specified in your message header, provided
this recipient is stored in a Kofax Communication Server address book.

To select and use an existing cover sheet do the following:
1. Open a message by selecting New from the Message menu or clicking the corresponding icon on

the toolbar.
2. Click anywhere in the Send Options area to open the Send Options window.
3. Click the Change Cover button to display a list of cover sheets.
4. Select a cover sheet with a single click. Your selected cover sheet should appear in the Cover Sheet

field above the list.
5. Click OK.
6. Click Text/Image from the View menu to see how your cover sheet will look. (To learn how to create

cover sheets, please see the KCS Clients Administrator’s Manual).

Using Default Templates
A template can be any message stored in any folder. TCfW does not provide special extensions for
templates as it does for cover sheets.

Your default message template is the message you start with when you select New from the Message
menu. It can contain all the components of any message: cover sheet, recipient list, subject, send options,
and message text. It may also contain just an empty text box. The purpose of having a default template is
to save you the time and trouble of specifying the same message components over and over again.

Creating a New Default Template
To create a new default template follow these steps:

1. Select New from the Message menu.
2. Enter and specify all the message components you would like your template to contain.
3. Select Save As from the Message menu and save this message, specifying a folder and a suitable

name in the Message Name field.
4. Click OK.

Selecting a New Default Template
To select a new default template follow these steps:

1. Click New Select Template from the Message menu.
The Select Template window opens.

2. Select the folder containing the message you want to use as your default template.
3. Select the message from the folder list.
4. Click the Default Template check box.
5. Click OK.
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The selected message (template) will now open each time you select New from the Message menu.

Authorizing Messages
For security reasons there are some messages that need to be authorized before being sent to the final
recipient. Some users are set as authorizers in their user profiles, and others don’t have the right to send
out certain messages without authorization.

If you don’t have the right to send certain messages out directly you must not only specify the final
recipient in the To field, but also the authorizer in the Auth field. The message is then relayed to the
authorizer. If he approves it, it is sent out from his workstation; otherwise it is sent back to you.

If you are an authorizer, outgoing messages from other users will first be sent to you. If you approve you
can sign the message and send it out, and if you disapprove you reject the message by clicking the Reject
icon or selecting Reject from the Message menu. The message is then sent back to the original sender.

There can be one or many authorizers for one message. The message is then simply sent from one
authorizer to the next every time it’s approved until it reaches the last authorizer in the chain. If he too
approves it, it is sent out.

Inserting Test Keys
A further security feature is test keys. You can insert test keys in a message if you have the right to do
so. If you need a test key on a message before it is sent out, you will have to enter a test key field in your
message and then send it to an authorizer, who will then insert the test key and signature before sending
it out.

Example for Authorizing a Message and Inserting a Test Key
In the example below, user SM writes a message to be sent to recipient ARROWS. Authorized user SM1
first has to enter a test key into the message, and then authorized user SM2 has to sign the message.

SM inserts a test key mark and a signature mark in the message. The test key mark will enable SM1
to insert the test key. The signature mark will enable SM2 to enter a signature. SM specifies the Auth
delivery type and clicks Send.

This is the message before SM sends it to SM1 for authorization:
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This is how the same message looks when SM1 receives it (the test key mark is replaced by a blue text
box during sending):

SM1 enters the test key and clicks the Authorize button. The message is then sent to SM2 for further
authorization.
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This is what the message looks like when SM2 receives it:

SM2 switches to Image Mode, where he proofreads and signs the message by clicking the Sign button.
He then selects Authorize from the Message menu to send the message to its final recipient.

Users SM1 and SM2 must have the proper rights defined in their user profiles in order to insert test keys
and sign messages. In addition, SM2 must have his signature stored in his user profile. (See the KCS
Clients Administrator’s Manual for complete information on user profiles.)

Inserting Signatures with WinWord
In the example below, user SM writes the following message, containing API key word commands, in
WinWord, to be sent to recipient ARROWS. Authorized user SM2 has to sign and authorize the message.

<<To: ARROWS>>

<<Auth: SM2>>

<<SEND>>

This is the text of the message

Best regards

<<Sign SM2>>

SM

SM2 receives the following message in TCfW:
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This is the message in Image Mode opened by user SM2 before signing. The file SIGNTEMP.TCI contains
the graphic shown in Image Mode instead of the signature. The rectangle represents the borders of
the signature. The position of the inserted signature is adjusted to the left lower corner of the key word
<<Sign>>.

User SM2 clicks Sign:
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This is the message (above) in Image Mode after the Sign button is clicked. The file SIGNNOW.TCI
contains the graphic displayed when Sign is clicked. If more than one signature mark is in the message,
you can move to the next signature mark by clicking the Next button.

When SM2 clicks the Sign button,

This signature is taken from his user profile and immediately displayed in Image Mode (See also Sending
Directly from Applications.)
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Drag & Drop
You can drag and drop within and between messages, and from folders to messages. If the drag operation
is started from within a message, the default drag mode is always Move. To copy, press and hold down
the CONTROL key while dragging. Copy drag mode is indicated by the "+" sign in the drag cursor. But you
can only copy messages from folders to open messages; not move them.

Message to Folder
1. Open a folder window by clicking the Folder menu and then by clicking Folder ..(1)
2. Select one or more messages in the message list.
3. Drag the messages to the folder where you want to copy the messages.
4. For each copy operation a window opens

 

If the message is saved to the message folder or to a private folder, a user-ID and a file name must
be specified.
If the message is saved to the system folder, a folder name and a file name must be specified. 
If the message is saved to the FIS folder, only a file name must be specified

5. If the message is opened from the inbox or outbox, you can select to terminate the message after
saving.

6. Click the OK button to save the message to the selected folder

Message to Message
When you drag and drop text from one message to another, you can either move or copy. (Remember
that you have to be in Text Mode to select text.) You can also copy or move a single recipient from the
Recipient list to any other open message. The destination message may be reduced to an icon in the
main window during drag and drop, but such icons are only visible when the onscreen window is not
maximized.

From Message Folder, FIS Folder or System Folder to Message
When you copy a message from the Message Folder, FIS Folder or System Folder to an open
message, the dragged message is linked to the open message. A message displayed in the message
area in Text Mode looks like this:
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< “FAX Server Functions” at “//SERVER/FIS/FNCTS” pages 1 >

Subsequent changes to the source message are automatically made in the destination message, because
only one version of the message exists.

From Inbox, Outbox or Personal Folders to Message
When you copy a message from the Inbox, Outbox or a personal folder to an open message, the dragged
message is embedded in the open message. A message displayed in the message area in Text Mode
looks as follows:

< “TCfW questions” from “//SCHMID C-DISK/SM/QUEST” pages 1 >

The source message is completely embedded in the destination message. Changes made later to the
source message have no effect on the destination message because the destination message contains a
copy of the source message.

Dragging Messages from a Folder to an Open Message
Follow these steps to drag a message from a folder to an open message:

1. Open an existing message or a new one.
2. Open a folder.
3. Click Tile from the Window menu. This will display all the open items arranged in the main window.
4. Select the message you want from the folder list and drag and drop it into the message area of your

open message.
An attachment line appears, showing the inserted message.

Adding/Editing Memo to Message
Perform the following steps to add/edit a Memo for a message in Inbox or Outbox folders:

1. Select the desired message in Inbox or Outbox folder.
2. Click Memo from the Edit menu. This will display the Memo window.
3. Add/edit the memo text in the text box.
4. Click the Save button to save the memo text.

Extracting cost center from message subject
TCfW extracts the part of message Subject enclosed in parentheses, that is "(" ")", and populates it in the
Cost Center field.

You can disable this by the setting the value of the following registry key to 0. (Default: 1)

HKEY_LOCAL_MACHINE\Software\Topcall\TCFW\Workstation
\ExtractCostCenterFromSubject
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Setting the value of ExtractCostCenterFromSubject to 0 also converts the "(" to "[" and ")" to "]" in
the Subject field.
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Address Books

Address books are used to store frequently used recipients. TCfW supports a System Address Book, a
Group Address Book, and a Personal Address Book for each user. Address books of other applications
also appear in the TCfW Address Book drop-down list.

Each user is automatically defined as a recipient in the System Address Book.

Authorization to use address books is defined in the User Profiles.

To select an address, book do the following:
1. Click the Address Book drop down list in the message window. (The same Address Book drop-

down list appears in the Address Book window, which opens when you select Address Book in the
Admin menu.)

2. Select the desired address book.

Address Book Window
The Address Book window lets you address your outgoing messages quickly and easily. You can also edit
existing recipients and create new ones. Open this window by clicking the Check Address button on the
toolbar.

This window also opens when you specify an incomplete or unknown address in the recipient field of the
Compose Message window.

Note This window is different from the Address Book window that opens from the Admin menu. You
cannot insert recipients into open messages from that window.
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The four buttons—To, cc, bcc, and Authorize, determine the delivery type.

For a detailed explanation of these four delivery types, see Addressing Messages.

To add a recipient to an open message, follow these steps:

1. Select the required address book from the Address Book drop down list.
2. Select a recipient from the list by clicking once.
3. Click one of the four delivery type buttons To, cc, bcc or Authorize.

The recipient is copied to the Recipient list along with the delivery type you selected. An alternative
is to double-click a recipient to copy him/her to the list with the default To delivery type. You can send
your message to as many recipients as you want simply by repeating these steps.
You might want to use Search Criteria to filter out some addresses when the address books become
too large. Double-click into the line just above the column headers (in our example, one of those
fields shows “SUN*”). As shown in the example above, a trailing asterisk stands for any string at the
end of the field. The search is not case sensitive.

Recipient Window
You can create new recipients or edit existing ones in the Recipient window. From the Address Book
(Admin menu) or Address Book window (Check Address button on the toolbar), click the New button to
enter a new recipient, or select a recipient and click Edit. In either case the Recipient window opens.
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The Recipient window consists of two separate areas:
• General area
• Address area

Note All mandatory fields in both areas appear in bold onscreen.

General Area
All fields in this area can be used in cover sheets. This area contains the basic information about each
recipient:
• Short name (user ID)
• Company
• Department
• Full Name
• Salutation
• Free Text (comment)

The Short Name field contains the abbreviation of the recipient that you can enter in the Recipient field of
the message window.
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Address Area
The address area, the lower half of the Recipient window, is where you define one or more sending
services with which the recipient can be reached. Each service is represented by an entry in the list.

To establish a service for the recipient, follow these steps:
1. Select a service from the Service drop-down list, and fill in any fields below this.
2. Enter a number in the small Address No. field to determine this services’ sequence — enter 1 if you

want Kofax Communication Server to use this service first when you send a message.
3. Check the Active check box, otherwise this service is not used, and is present in the list only to save

you the trouble of retyping it in case you decide to activate it again.
4. Click the Save Addr button once you defined the service to put it in the list.
5. Click OK to save your settings and exit this window.

The fields and boxes of the address area are explained in detail below.

Service Field
Depending on the type of service, the address area offers different windows for entering addresses. Kofax
Communication Server supports the services of Fax, Telex, X400, TC and Free Format. The system does
not check the syntax of messages to be sent by other service types.

Address Number Field
The address sequence number, together with the Active check box, controls the order in which the
address is used. When you enter a recipient's short name, Kofax Communication Server sends the
message to the first address, the one with the lowest address sequence number, provided the address is
active. If Kofax Communication Server cannot deliver the message, it will use the next active address as
an alternate number for subsequent sending attempts.

Follow these steps to change the sequence number of an address:
1. Select a recipient from an Address list.
2. Click the Edit button.
3. Select the address you want to change the sequence for in the recipient’s Address list at the bottom

of the Recipient window.
4. Enter a new sequence number for this service in the Address Number field.
5. Click the Save Addr button.

The selected service will take the new sequence number, and all other services in the list will shift
according to this change.

Active Check Box
The address entry is only used in the address if this check box contains an X (=active). You can
deactivate an address that is temporarily out of service instead of deleting it. Click the Active check box to
toggle it.
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Number Field*
If the Number field is available for the service selected, enter the fax number, telex number, etc. There is
one exception: in case of X400, clicking the Number field opens the X400 Address window, shown below:

Answer Back Field*
If the Answer Back field is available for the service selected, enter the fax or telex answer back.

Free Address Field*
If the Free Address field is available for the service selected, enter the address according to the
convention of the service specified. The system does not perform a syntax check for this field.

User ID and Node Fields*
If the User ID and Node fields are available for the service selected, enter the recipients’ User ID and
Node name, if required.

Address Field*
If the Address field is available for the service selected, click within this field to open the Postal Address
window and enter the address.

Note The fields with a trailing asterisk * are service dependent.
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Folders on the Kofax Communication Server

You can use folders to organize your messages.

The following folders are installed on TCfW by default:

Inbox Received messages

Outbox Messages waiting to be sent.

Message Folder Messages filed by the user (one folder per user on Kofax Communication
Server)

Private Folders Messages filed by the user (unlimited PC or LAN folders)

FIS Folder Documents of the Fax Information System

System Folder System files

Log Entries Queue length log entries and user defined log entries

Access authorization to folders is defined in the User Profiles.

Opening a Folder
1. Select a folder window from the Folder menu, or select an open Folder window from the Window

menu.
2. Select a folder from the tree view on the left side of the Folder window.

Deleting an Entry in a Folder
(not possible with the Inbox, the Outbox and the Archive)

1. Open a folder.
2. Remove entries from the list by selecting them and clicking Delete in the Message menu. This only

works in your Message Folder and Private Folder. You can select multiple messages for deletion
by holding the SHIFT key or the CTRL key while clicking on the entries.

3. Click Refresh (in the tool bar) or F5 to see if the entries have been removed.

Previewing Messages in a Folder Window
You can preview messages in Image Mode directly in the folder window:
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Move the mouse pointer to the lower end of the folder window. Just before it becomes a double arrow for
window resizing, it becomes a split view grip, which looks like two vertical bars.

Drag the grip upwards. The preview section appears when you release the mouse button.

It is recommended to preview messages in full screen mode. Click the button beside the Close button to
resize the folder window to full screen mode.

Opening an Entry
There are two ways to open a message entry via the Message menu:

If there is no folder window open:
1. Select Open from the Message menu. This opens the Open Message window.
2. Select the folder containing the desired message (on the left side of this window). The selected folder

appears in the Folder field.
3. Double-click the desired entry from the list. The selected message appears.

Example: From a folder window:

You can open a single message entry directly from the folder window by double-clicking on the entry.

When opening multiple selected entries, select them using SHIFT-CLICK and CONTROL-CLICK, and use
Open from the Message menu to open them.

Elements of Folder Windows
Each of the four folder windows can display any folder that is selected from its tree view.
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Folder Selection
The tree view on the left side allows you to select the folder to view. It is structured in two levels. The first
level allows you to select the TCOSS server or the personal user folders. Usually, an Archive server is
also shown.

The second level allows you to select a folder that is accessible to you on the server. Usually the folders
mentioned above are selectable.

When you select a folder, message data is retrieved from the TCOSS server and displayed.

Message Entries
The message entries are shown in a list view. You can select messages from here by clicking the
message entry. You can use the scroll bar or the arrow keys (including PGUP and PGDN) to navigate.
Use the SHIFT and CTRL modifier keys to select multiple entries. This is useful if you want to print several
messages at once for example.

1. Double-click an entry to open it. In order to open multiple entries use Open from the Message menu,
since the first click makes the multiple selection disappear.

2. You can change the width of each column with the mouse by doing the following:
3. Place the mouse between two columns in the column header line until the mouse arrow changes into

a bi-directional arrow.
4. Drag the line separating two fields to resize your fields, or drag them together to hide a field

completely.
5. You can also double-click between two columns to resize the column so that it fits to the width of all

its entries.
The current setup of each folder window is stored when you close the application.

Note To reduce network traffic, only the messages displayed in a folder window are fetched from
the server (even if there are more). Further messages are retrieved when the message area is
scrolled downwards.

Filtering and Sorting Messages

The list view’s column header shows the titles of each column (Subject, Recipient, Status, etc. Clicking
into a column header opens the following menu:

Ascending Allows you to specify a sorting order.
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Descending Allows you to specify a sorting order.

View Settings Allows you to set the column settings.

Current Filter Allows you to view the current filters.

Set Filters Allows you to set a filter in order to restrict the entries shown.

The input focus will always appear on the field (e.g. From, Subject,...) from which the Set Filters
command was activated.

A filter entry may end with an asterisk (*), which works as a wild card to match any remaining string value.
For example, S* in the recipient field matches all names that start with an S.

Note For the Archive Folder, there is a different filtering method. (See Searching the Archive).

View Settings Window
This window allows you to determine the view of your folder columns. You can simply re-arrange the
sequence of the columns with the mouse by means of drag & drop.

In the View Settings window you can define the columns to be shown. Open this window through View
Settings in the column header menu or View Settings in the Folder menu.
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Items of the window:

Custom Choose this selection to make an individual set of fields.

Defined in User Profile Choose this selection to use one of the pre-defined sets of fields.
The parameters Extended Folder View and Tech User determine the view
used. Different views are only available for the Inbox and the Outbox.

Add Adds a selected field to the Displayed Fields list.

Remove Removes a selected field from the Displayed Fields list.

Move Up Moves a selected item up in the Displayed Fields list.

Move Down Moves a selected item down in the Displayed Fields list.

If Custom is selected all fields remaining in the Available Fields list are still presented for filtering in the
Filter window. Fields in the Used Fields list are presented on top, fields in the Available Fields list are
presented at the end in the Filter window. This is different to the Defined in User Profile behavior. Here
only the fields presented in the folder view are available for filtering.

If fields combined with a status icon are moved from the leftmost position to any other position, the icon
always remains on the far left.
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If a Custom view is active, dragging the column header with the mouse to the new position can also
change the column order. This is not possible for a User Profile Defined view.

Preview Area
This area shows the last message selected in Image Mode. In order to make the preview area visible,
follow these steps:

1. Move the mouse pointer to the lower end of the folder window. Just before it becomes a double
arrow for window resizing, it becomes a split view grip, which looks like two vertical bars.

2. Drag the grip upwards. The preview section appears when you release the mouse button.
3. Click the Restore button to resize the folder window to full screen mode.

It is recommended to preview messages in full screen mode.

Inbox
The Inbox shows all your incoming messages. Messages can be categorized as New Message, Touched
or Marked Completed, as shown by their corresponding status icons.

Marking an Inbox Entry as Completed
To mark a message as completed, follow these steps:

1. Select its entry from the folder entry list
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2. Click the Mark Completed button or select Mark Completed from the Message menu.
3. Click Refresh (F5).

A new (untouched) entry cannot be marked completed unless Terminate Incoming is enabled in
your user profile. Once an entry has been marked completed it will no longer appear in the list of
open send orders. Your user profile can be configured to automatically mark messages as completed
once you open them.

Marking an Inbox Entry as Read/Unread
1. Select its entry from the folder entry list
2. To mark messages as read, click the Edit menu, and then click Mark as Read.
3. To mark messages as unread, click the Edit menu, and then click Mark as Unread

Opening an Entry
Double-click any field of an entry to open it. If the selected message begins with text, it opens in Text
Mode; if not, the message is displayed in Image Mode.

You also can use Open from the Message menu to select multiple entries. Use SHIFT-LEFT MOUSE
CLICK and CONTROL- LEFT MOUSE CLICK to select them.

Column Headers
Depending on your User Profile, your Inbox shows a specified set of fields; a simple selection for standard
users, an extended set for the Distributor and/or administrator and a complete set for the TECH user.

Standard Inbox Fields
Normally following fields are available in your Inbox:

Status
Every entry in the Inbox has one of the following statuses:

 New Message No action has been performed. The message has
yet to be printed or viewed. Entry cannot be marked
completed.

 Touched Entry already opened. Message has been printed or
viewed. You can mark the entry as completed now.

Resubmitted message. The message has yet to
be printed or viewed. Entry cannot be marked
completed.

 Marked completed Message still in Kofax Communication Server.

 Marked completed—Log Entry Only the log entry exists; the message itself has been
deleted.

 Cancelled Message was cancelled by the sender.

81



Kofax Communication Server TCfW Communication Server Client User Manual

 Cancelled—Log Entry Message was cancelled by the sender. Only the log
entry exists; the message itself has been deleted.

The following statuses can appear in the Inbox of a Kofax Communication Server channel (fax, telex, etc.)
or if sending has been initiated by another software product.

 Sending Sending in progress.

 Active—Forwarded Sending in progress and message routed to next node.

 Inactive—Problems Message marked completed due to a send error.

 Sent OK Message has been sent successfully.

 New Message(locked) Number locking feature is active for this channel.

If the filter is set to All, all messages, including those marked completed by the user, are displayed. You
would normally want to set this filter to All Non Terminated.

You can filter out messages with the following statuses:

 All Entries Shows the contents of the whole Inbox.

 All Non-Marked Completed Shows all messages which have not been marked completed by
the user.

cc/To
You can set the following delivery types:

To To address the recipient directly.

cc To send a carbon copy of the original message to the recipient.

bcc To send a blind carbon copy of the original message.

Auth Message waiting for authorization. Users receiving a message for authorization
without the related right set in their User Profile can only reject the message.

To
User ID of the recipient.

You can filter out any user ID, provided the user specified is a member of your group, or if he/she is the
representative of the selected user.

Users authorized to access Inbox All Users (as set in their user profiles) can specify any user ID or leave
this field blank to view and/or open all users’ messages.

Recip. Group
Displays the group of the recipient.
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Note Only messages sent with TC/SP 7.25.01 or higher show group names in the corresponding fields.
Messages created with previous TC/SP versions do not show any group information. The corresponding
fields are blank. If the filter ‘Develop’ is set as group selection criteria for instance, only those entries
containing ‘Develop’ in the group field is shown. This means that the group key cannot be used as a
filter for messages created with previous TC/SP versions. In this case you are forced to use another
filter.

Group fields are only visible in the program if TC/SP version 7.25.01 or higher is used.

From
Describes the sender of the message. The content of this field depends on the sender type.

In the case of external senders, this field will contain the (service) and answer back received from
the public lines. Channel groups are configured on Kofax Communication Server. In standard Kofax
Communication Server configurations, the following channel groups are defaults:

F = Telefax, X = Telex, T = Teletex

Ask the administrator in your company for channel group names and their meanings.

Examples:
• F, +4316613321 = Incoming fax from the number +4316613321
• X, 111388/TCINT = Incoming telex from the number 111388/TCINT

In the case of internal senders this field contains the senders’ short name, full name and service (MILLER,
John Miller, LOCAL), or service and short name (INT, JASON1).

Origin. Group:
Displays the group of the sender.

Note Only messages sent with TC/SP 7.25.01 or higher show group names in the corresponding fields.
Messages created with previous TC/SP versions do not show any group information. The corresponding
fields are blank. If the filter ‘Develop’ is set as group selection criteria for instance, only those entries
containing ‘Develop’ in the group field are shown. This means, that the group key cannot be used as
a filter for messages created with previous TC/SP versions. In this case you are forced to use another
filter.

Group fields are only visible in the program if TC/SP version 7.25.01 or higher is used.

Subject
Enter comments in this optional field to indicate the contents of the message.

External sender: This field is empty for incoming fax and telex messages. The Distributor can fill it in
during manual distribution.

Internal sender: The Subject field of the message as entered by the sender.
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User Action
Shows the last action performed with this message.

None Message was automatically put in the Inbox by Kofax Communication Server. No
further actions have been taken.

Saved Message was opened for copying.

Read Message was opened for viewing.

Printed Message was opened for printing.

Distributed Message was distributed by the Distributor.

Replied Message was opened for replying.

Forwarded Message was opened for forwarding.

Reactivated Message was reactivated for new sending.

Rejected Message needing authorization but was rejected.

Authorized Message was authorized.

The status of the message changes to Touched after the message is viewed, printed, copied, distributed,
replied to or forwarded.

File Size
The size of the message in bytes.

Created At
This is the reception time for external messages. For internal messages it is the creation time of the
message and not the reception time.

Message ID
The Message ID serves a message tracking ID of a message within TCOSS.

(For a description of the additional folder fields only visible to users with special authorization, see the
KCS Clients Administrator’s Manual.)

Memo
The memo text can be used to provide additional information about the messages.

Receive Duration
Displays the duration in seconds for reception of a message from a public line, such as fax or voice mail.
This duration is the time difference between reception end time (Received/Term.) and reception start time
(Created at) values.

It displays zero if the message was posted using any TCSI client, such as TCfW, TC/Link-XX.
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Outbox
The Outbox shows all messages you sent. For each recipient of a message, one entry line is created
in the Outbox. This entry shows, among other things, the Status of delivery. Entries can be categorized
as Active, Inactive, or Marked Completed. Active means the message is in process of being sent.
Inactive means the message couldn't be sent due to problems. Marked Completed include messages sent
successfully as well as those cancelled by the user.

As long as a message has not been sent, its entry is not marked completed and can therefore not
be deleted automatically. After successful sending or manual cancellation, the message is Marked
Completed and subsequently deleted automatically over time as new messages arrive.

If a message could not be sent successfully, you have to intervene with the following options:
• Click the Cancel Mess. button to deactivate the send order.
• Click the Reactivate button to reset the sending attempts.
• Click the Correct button. This opens the Recipient window in which you can correct the address.
• Click the Send button to resend a message.

It is also possible to cancel (mark completed – i.e. the check mark icon on the toolbar) a message, which
is in Sending status. This will immediately terminate sending of the message, and set the message to
cancel.

A window will warn you that you are about to cancel an outbound transmission. If you click the Yes button,
the outbound transmission is cancelled.
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The status of messages in the Outbox, which are cancelled during transmission, are displayed with: (See
Status)

Status Error Code

Cancelled

SC Cancelled during transmission

Resend a Message
Messages from the outbox view can be resend without opening the message. In case an error occurs
during the resending process, TCfW displays a message box window with the error description. After
clicking the Ok button TCfW resends the next selected message.

How to Resend a Message
1. Select the message(s) which you want to resend
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2. Click the send button  or select Send from the Message menu.

3. A message box window opens where you can start the resending
process by clicking the Yes button or cancel it by clicking the No
button

4. If you click Yes, a new window opens which shows the progress of the resending process
 

You can cancel the resending process any time by clicking the Cancel button
5. At last TCfW displays a message window with the number of sent messages
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Reroute a Message
Messages from the outbox view can be rerouted without opening the messages.

How to Reroute a Message
1. Select the message(s) which you want to reroute.

2. Click  Reroute. The Reroute window opens.
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3. Specify new recipient(s) for the messages and click Reroute. A window is displayed where you must
confirm the rerouting.

4. Click Yes to reroute all selected messages. If a message cannot be sent because of an error a window
is shown where you can
• abort the complete reroute operation
• ignore the error
• send the message again
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Standard Outbox Fields
Normally these fields should be available in your Outbox:

Status
Each message entry in the Outbox has one of the following statuses:

 Waiting Message has arrived in the Outbox and Kofax
Communication Server has yet to perform any sending
attempts. In case of internal sending this status means that
the message has not been touched yet.

 Waiting(locked) Message has arrived in the Outbox. Number locking is active
for this channel. Since another message with the same
telephone number is already active, this message is locked.

 Active Sending in progress. At least one sending attempt has
been made. In case of internal sending this means that the
message has been touched (viewed, printed, and copied).

 Sending Sending in progress. In case of internal sending this status
does not exist.

 Sending(locked) Sending in progress. Number locking is active for this
channel. Number locking means that out of two or more send
orders to the same telephone number only one can be active
at any time.

 Active — Forwarded Sending in progress and message routed to next node. In
case of internal sending this status does not exist.

 Inactive — Problems Message marked completed due to a send error. This status
is set when Kofax Communication Server has finished
all send retries and the message still could not be sent
successfully. User intervention is necessary to cancel, correct
or reactivate the message. Cancel Mess. leads to the
status Cancelled. Correct and Reactivate lead to either the
Waiting or Sending status. In case of internal sending this
status does not exist.

 Sent OK Message was sent successfully. This status appears only
when the message was sent by applications other than
TCfW.

 Sent OK — Log Entry Message has been delivered successfully. Only the log entry
exists; the message itself was deleted.

 Cancelled: Message was cancelled by the user.

 Cancelled: (SC) The message was cancelled by the user during transmission.

 Cancelled—Log Entry Message was cancelled by the user. Only the log entry
exists; the message itself was deleted.
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 Send Attempt A logged send attempt from the short-term archive. This
means e.g. for a fax line that all cases where the distant
subscriber was busy or not reachable for some other reason
are now documented in the short term archive.

You can filter out messages with the following statuses:

 All Shows the contents of the whole Outbox.

 All Send Attempts Shows all send attempts.

 All+Send Attempts Shows all messages and all send attempts.

 Problems Shows all messages that were marked completed due to send error.

 Messages Not Sent Shows all messages not yet sent (including the ones with the states of
Waiting, Active, and Inactive—Problems).

 Cancelled Shows all cancelled messages.

cc/To
Delivery type of the recipient of the message. Possible delivery types:

To To address the recipient directly.

cc To send a carbon copy of the original message to the recipient.

bcc To send a blind carbon copy of the original message.

Auth Message waiting for authorization. Users receiving a message for authorization without the
related right set in their User Profile can only reject the message.

To
Describes the recipient of the message. It consists of short name, full name, and a list of services. (e.g.,
MILLER, John Miller, FAX, TTX, X.400). The list of services is taken from the recipient’s address book
entry, and contains all the active services specified. The first active address is used for primary sending;
the other services are used as alternate addresses when the primary address doesn't work.

Recip. Group
Displays the group of the recipient.

Note Only messages sent with TC/SP 7.25.01 or higher show group names in the corresponding fields.
Messages created with previous TC/SP versions do not show any group information. The corresponding
fields are blank. If the filter ‘Develop’ is set as group selection criteria for instance, only those entries
containing ‘Develop’ in the group field is shown. This means that the group key cannot be used as a
filter for messages created with previous TC/SP versions. In this case you are forced to use another
filter.

Group fields are only visible in the program if TC/SP version 7.25.01 or higher is used.
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From
User ID of the sender (e.g., MILLER)

With the corresponding rights set in the User Profile, a user can select any user ID as a filter, as long as
he/she and the user specified belong to the same group or if he/she is the specified user's representative.

Users authorized to access Outbox All Users (as set in the User Profile) can specify any user ID or
leave this field blank to see and/or open all users’ messages.

Origin. Group:
Displays the group of the sender.

Note Only messages sent with TC/SP 7.25.01 or higher show group names in the corresponding fields.
Messages created with previous TC/SP versions do not show any group information. The corresponding
fields are blank. If e.g. the filter ‘DEVELOP’ is set as group selection criteria, only entries containing
‘DEVELOP’ in the group field are shown. This will say, that the group key as selection criteria cannot be
used for messages created with previous TC/SP versions. In this case still the user-id of a member in
the same group must be used.

Group fields are only visible, if TC/SP version 7.25.01 or higher is used.

Subject
The subject of the message. Optional.

Retries Left
Shows the number of remaining sending attempts for the send order. Kofax Communication Server starts
with nine retries left.

Priority
The sender specifies the sending priority. Kofax Communication Server has 13 priority levels: low ,
normal ,high , high 1, high 2, high 3, high 4, high 5, high 6, high 7, high 8, high 9 and highest priority.

Note The priority levels high1 .. highest requires at least TCOSS 7.44.03

Error
Contains information about a send error, such as a document that was only partly received.

Response
May contain additional information helpful in some error situations such as the recipients’ answer back
(e.g., +4316613321).
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File Size
Message size in bytes. Kofax Communication Server automatically calculates this when it stores the
message.

Send Time
Time and date the message was sent. With messages not yet sent, this field contains the time and date of
the next sending attempt.

Intended Time
It gives the time when the message should have been sent, which may be the sending time specified by
the user or the time of posting. If the user specified a sending time which had already passed at the time
the message was posted, the intended time gives the time of posting.

Cost Center
Cost center to which the transmission is billed. Defined in the senders’ User Profile.

Costs
The cost of sending in units. The unit is configured on Kofax Communication Server. No fee calculation is
provided on Kofax Communication Server for local sending.(For a description of the additional folder fields
only visible to users with special authorization, see the KCS Clients Administrator’s Manual.)

Message ID
The Message ID serves a message tracking ID of a message within TCOSS.

Memo
The memo text can be used to provide additional information about the messages.

Message Folder
Each user has one Message Folder on the TCOSS server. You can store the messages and cover sheets
you want to save in this folder.
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Standard Message Folder Fields
Each user sees the following fields in the Message Folder:

User ID
The short name of the user.

Message Name
The name the file has on Kofax Communication Server.

Subject
The subject of the message. (Optional)

Created at
Date and time the message was stored on Kofax Communication Server.

File Size
Message size in bytes. This field is automatically calculated by Kofax Communication Server when it
stores the message.

Message ID
The Message ID serves a message tracking ID of a message within TCOSS.
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FIS Folder
The Fax Information System stores documents for easy retrieval from both internal and external
locations. These stored documents are usually company documents such as leaflets, forms, price lists
and any other information your company wants to make widely available. You can access FIS documents
via TCfW or remotely from any fax machine. You can also attach FIS documents to outgoing messages.

You can store any message in the FIS Folder, simply store it the same way you store a message in
any other folder. Remember that the name of the message has to be numerical for fax retrieval. Access
authorization to the FIS Folder is defined in user profiles.

Difference between the FIS Folder and normal Message Folders:

Filters for the file name are pre-defined in User Profiles so each user can only access a limited selection
of FIS documents.

To access the FIS Folder remotely, you need a fax PIN code, a fax password and a FIS prefix defined in
your User Profile. The filter for the Message Name field consists of the TCfW FIS prefix and the filter
entered.(See Message Folder for a description of FIS-Folder fields.)

You can create and delete self-defined Private Folders. These folders are stored in your PC or
LAN environment and not on the TCOSS server. You cannot create or delete folders on the Kofax
Communication Server, but you can copy them to your PC environment.

Private Folders
You can create your own personal user folders on your Workstation, in which you can save your
messages.
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Note If your User ID is longer than 12 characters, you are not able to save messages into these folders.
By the same token you cannot copy a message folder into a private folder.

Creating a New Private Folder
After you create a folder, other users with access to the folders’ directory are able to use this folder, too.

The Create / Add Folder window allows you to manage folders stored on your computers’ hard disk or in
the LAN.

1. Select Create / Add Folder from the Folder menu.
2. Enter a name for the new folder in the Folder Name field.
3. Specify the path (drive and directory) where you want the folder to be located.
4. Click OK.

Deleting Private Folders
1. Select Delete Folder from the Folder menu.
2. Select the folder you want to delete from the Delete Folder drop-down list.
3. Confirm and click OK.

Copying Folders
This feature allows you to copy selected folder entries from a system-wide folder into a personal user
folder. This does not work in the Inbox and Outbox. (See Creating a New Private Folder for a description
of how a personal user folder is created.)

Follow these steps to copy a folder:
1. Open the folder you want to copy in a Folder window.
2. Select the entries you want to copy. You may do this by setting filters. To do so click the column

header and select Set Filters from the menu. (See the “Elements of folder windows” section).
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3. Choose Copy Folder from the Folder menu.
4. Select the destination folder from the drop-down list.
5. Click Start Copy.

Note If messages are copied from the FIS Folder to a private folder the original folder name
(+MAIL5V) is preserved.

Exporting Folder Views
This feature allows you to create an ASCII file of a folder view in a directory you specify. The contents of
the folder are not exported.

To export folder views follow these steps:
1. Open the folder you want to export.
2. Select the messages to export by setting a filter. Click the column header on the right pane to do so.

(See Elements of Folder Windows)
3. Select Export Fields in the Folder menu. The Export Folder To window appears.
4. Specify file name and path for export.
5. Click OK.

Log Entries
A queue length log agent writes log entries in regular intervals to the short term archive to be later
processed by TC/Report. NT performance counters allow a live view of TCOSS queue lengths.

All messages waiting to be sent immediately and messages waiting for a retry after a failed send attempt
are counted for the total queue length. Not counted are messages with a specific send time, if this time
has not yet passed. Also not counted are messages which are currently being sent, messages already
routed to another node (state “at next node”) and messages in state “Inactive – Problems” (not sent, no
more send attempts).

(For more information about log entries see the chapter Queue Length Log in the KCS Clients
Administrator’s Manual.)
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Chapter 7

Kofax Communication Server TC/Archive

The Kofax Communication Server Archive allows you to secure your messages, since all messages to
and from all platforms are integrated into a single storage and retrieval point. Messages routed via the
Kofax Communication Server messaging system as well as all messages sent via one of the supported
mail clients are automatically archived making local storing or archiving of messages obsolete.

You can easily retrieve a message with the integrated search engine.

Note For users that don’t have the TC/Archive Server installed, the menu Archive – Demo shows a
demonstration of the Archive retrieval windows.

Searching the Archive
During a search, the entries found are continuously added to the folder window.

If an off-line volume (a whole TC/Archive Server volume that has been filled and burned onto a CD and
is thus not currently available on the Archive Server) is required (either for index or data) TCfW opens a
notification window. You will need to make the requested volume available either by inserting the CD-ROM
in the drive at your own workstation or in the Archive-Server’s CD-ROM drive and specifying the path.

To search the Archive, follow these steps:
1. Select an Archive folder from the tree view in the left pane.
2. Click the Search button in the toolbar. The Archive window opens.
3. Enter the search string. You can also specify further restrictions like recipients, senders or dates.
4. Click Search Now or press Enter to start searching the Archive.

The results are displayed in the right pane. If you were given the rights you may attach them to a new
message by double-clicking them.

Note If you have no Archive Server installed, you won’t see an Archive Folder in your folder
window.

Tips for Efficient Searching
• If the word specified does not end with a ‘.’ (dot), the search will return matches of that word at the

beginning of others. This applies to the Search For Text field and to enter criteria in the Advanced tab.
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This means that if a search is submitted for the word ‘order’ the search will return the words ‘orders’,
‘ordering’ and ‘ordered’.

• If an exact match is required, the specified word must end with a ‘.’ (dot). The TCOSS server then looks
for whole words only. This applies to the Search For Text field and to input in the Advanced tab.

• By default, TCfW and TC/Web apply a wildcard (*) to a string in a text search. This means that
searching of strings “text” and “text*” will return a similar result. Usage of a wildcard (*) before text is not
allowed.

• Allowed keywords for all input fields are ‘AND’, ‘OR’ and ‘NOT’ in any combination. The keywords must
be specified in capital letters, otherwise they are treated like normal search words.

• Parentheses are not supported.
• The search words are not case sensitive.
• Phrases are not supported.
• A string may be searched for in a particular field (like the subject field or text content) or in all fields.
• If you don’t specify a time, the search is conducted on the online volumes (still available on the disk),

starting with the most recent one. To search in offline volumes (already saved on CD) you need to
specify a time range. The search may be restricted to a particular volume or a range of volumes
(implicit setting of time range).

• The Archive search returns a list of mail entries.
• If one document was sent to a number of recipients all mail entries appears in the search result (this

does not apply to the inbox-only view).
• The result list of an Archive search is always sorted by archiving time (starting with the most recent

message).
• The Archive search supports Inbox and Outbox views. Additionally a general view of all entries (both

in the Inbox and in the Outbox) is available.

The following screenshot shows how to retrieve messages from user ‘TH’ or ‘WK’ containing the text
‘Special’ in user ‘SM’s Inbox.

The Archive offers optimized search for all text content and for the following fields:

Search for Text
Words entered here are searched for in the following message parts:
• Subject
• Text parts
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• Message number
• Message name

You may change these settings in the Advanced tab of the Archive search window.

To / From
You can specify the name or number of a recipient or sender in this field. If only the Inbox is selected it is
treated as a filter for the sender, and if only the Outbox is selected then it is considered as a filter for the
recipient. In case that both the Inbox and the Outbox are selected the search applies to both the recipient
and the sender fields.

User / Group
You can only enter data in this field if you were granted the rights to do so. If you don’t have the Group
Right or the All Right, this field is gray and contain your User ID or that of the user currently logged in.

The Date & Time tab allows you to further expand the search criteria by specifying a date range. All
Messages On- and Off-Line is selected by default. Should you select a date range that lies beyond the
On-Line volumes, the Archive Server automatically searches in the Off-Line volumes.

All Messages On-Line
When this option is selected the search is conducted in the Archive volumes that are currently On-Line in
the TC/Archive Server.

All Messages On- and Off-Line
When this option is selected the search is conducted in both the On-Line and the Off-Line volumes. During
the search the server may prompt you to insert an Off-Line volume CD-Rom and to specify the path for
that specific volume.

An Off-Line volume is a whole TC/Archive Server volume that has been filled and burned onto a CD and is
thus not currently available on the Archive Server.
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The path for an Off-Line volume must be specified in the form ‘\\pcname\sharename’.

The Advanced tab, allows you to specify the search even further and enter more than one search
criterion. For each option you check, you may enter the text this field should contain. Once you’ve entered
the text click the Add button or delete a previously set condition by clicking the Delete button.

This tab also shows exactly in which fields the keywords are used for search.

Search Too Complex Information in Search Result
If a search is getting too complex, TC/Archive may return entries, which do not meet all search criteria.

TC/Archive reports in all affected entries of a search result if some of the search conditions could not be
resolved because too many matching strings exist in a particular volume.

This may happen when using wildcards, e.g. when searching for "A*" in the text content.

The search string "A*" matches all words in the index starting with ‘A’ like "aback", "abacus", "abaft",
"abalone", "abandon" etc., but there is a maximum of 100 strings whose occurrences can be combined in
one search.

If the limit of 100 would be exceeded, the complete search attribute is skipped (treated as always true).

A TCfW client release 3.04.01 or higher will mark the entries, which may not meet all search criteria, with
a special icon containing a question mark.

In any search too complex case the result may contain more entries than the correct selection, but not
less.
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The Fax Information System (FIS)

The Fax Information System (FIS) enables you to store and retrieve important documents. These
documents can be leaflets, forms, price-lists and any other information your company wants to make
widely available. You can access FIS documents via TCfW or remotely from any fax machine. You can
also attach FIS documents to your outgoing messages.

Access authorization to the FIS Folder is defined in user profiles.(See also  FIS Folder for information on
how to create private FIS Folders.)

Selecting and Viewing FIS Messages
With TCfW, you simply open the FIS Folder and see all the messages to which you have access. Each
FIS message has a unique name. If FIS messages are to be accessed by fax, their names must be
numerical.

To view a message in the FIS Folder, do the following:
1. Open the FIS Folder in a Folder window.
2. Scroll to the document you want to view. (You can filter the messages being displayed by setting

search criteria. To do this, click the column header of the right pane with your left mouse button. (See
Elements of Folder Windows))

3. Open the message by double-clicking it.

Remote Retrieval of FIS Documents
You can access FIS Folder files from remote locations. If you are a registered user with your own user
profile, all you need is a touch tone phone and a fax machine. Then all you need to do is call the TCOSS
server, enter your PIN code and the document number you want to retrieve.

Your PIN code and default fax number are defined in your user profile. Your administrator can look into
your user profile to see or define your PIN code. (See the KCS Clients Administrator’s Manual for detailed
information on user profiles.)

Retrieving FIS Messages with a Telephone and Fax Machine
The document is delivered to the default fax number set in your user profile.

Example: 6659272 (prompt) 84711 (= example PIN code) 73 104 # (confirmation beep)
1. Phone TC’s FIS access number (6659272) and wait for the prompt tone.
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2. Enter your PIN code (touch tone phone required).
3. Enter the FIS command (73) followed by the FIS document number.
4. Press # and wait for confirmation (1 beep) before hanging up.

Sending FIS Messages to a Fax Number Not Specified in Your User Profile
The document is sent to the fax number you entered.

Example: 6659272 (prompt) 84711 73 104 0 6613321 # (confirmation beep)

Note You can retrieve more than one FIS document during one call (e.g., 84711 73104 * 73105 *
73243 * 0 6613321 # will send FIS documents 104, 105 and 243 to FAX number 6613321 with routing
command 0, send now). Enter ** to clear the previous command entered and to get a new prompt.

1. Phone TC’s FIS access number (6659272) and wait for the prompt tone.
2. Enter your PIN code (touch tone phone required).
3. Enter the FIS command (73) followed by the document number.
4. Enter 0 (send now) followed by the fax number to which you want the message sent.
5. Press # and wait for confirmation (1 beep) before hanging up.

Adding Documents to the FIS Folder
You can store any message in the FIS folder. If you want to add a message to the FIS Folder simply
store it as you would in any other folder. Remember that the name of the message has to be numerical to
permit remote retrieval by fax.

Follow these steps to add a document to the FIS Folder:
1. Open the message you want to add to the FIS Folder.
2. Select Save As from the Message menu. The Save As window opens.
3. Specify the FIS Folder.
4. Give the message a name (only messages with numerical names can be retrieved remotely).
5. Click OK.
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TC Preferences

TC Preferences provide a common interface for configuring client application settings. These can be
stored either in the current user's local or roaming windows profile, the local workstation configuration or
the TC user profile. In order to access settings stored in the TC user profile you are required to login using
TC Login.

As special knowledge is required to set most of these Preferences, your administrator will set these for
you. At this point we will only describe those settings relevant to you, namely the TC Voice Player.

You can access Preferences via the integrated button or menu item in your mail application, via the Tools
menu item in the Fax Viewer and the Voice Player, or via the Admin menu in TCfW.

TC Voice Mail
TC integrated Voice Mail acts like a standard voice mail system. It is fully integrated with your email
environment. You will receive your voice mail messages in your standard inbox along with all other types
of messages. (See the TC Voice Mail Manual for more information on TC Voice Mail)

There are two tabs in Preferences that allow you to set the options for Voice Mail: the Out of Office tab
and the Personal Identification tab.

Out of Office
This tab allows you to set options regarding the personal greeting on your extension when you receive a
call that you cannot answer.

You can record different greetings for different situations, for instance when you are on vacation or simply
not in your office because you are in a meeting. You can also have different greetings for external calls
and for internal calls by clicking the Use different settings for internal calls check box.
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To create a voice prompt for a new status, follow these steps:

1. Click the New Status button. The cursor will move to the next empty line in the Status list.
2. Enter a name for your new status in this line.
3. Click the Record button to record your new voice prompt. The TC Voice Player appears.
4. Click the record button in the Player and record your voice prompt.
5. To listen to your prompt you can either click the play button in the TC Voice Player or Play in the Out

of Office tab if you have already closed the Player.
To delete a prompt simply click System Default. If you don’t record a new prompt the new status you
set will have the default prompt.
To delete a complete status from the list, place the cursor on that status and click the Delete Status
button.
If you want to have a different prompt for internal calls than for external calls for one status, check the
Use different settings for internal calls check box and record your voice prompt for internal calls
by following the steps described above.
If you don’t want callers to leave messages, when you’re on vacation for a long period of time for
example, you can check the Disable leaving of voice messages check box.
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Personal Identification
This tab allows you to set the necessary password to access your voice messages on the phone and
to record your Personal Identification, i.e., your name to be used when you leave voice messages on
someone else’s extension.

Speech Profiles
You can define the settings for the text-to-speech functionality of voice mail in this tab.

You can choose the language and the speaker the text should be read in. You can set up to 4 different
speech profiles, with 4 different languages.

Note If the Management Console cannot connect to a voice server, then you will not be able to change
the settings.
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To create a new profile, follow these steps:

1. Click the New Profile button. The cursor will jump to the next empty line in the profile list.
2. Give your new profile a name. The new profile will automatically be assigned a new number, which

you have to dial on the phone if you want to activate it.

Configure your profile
Configure your profile by doing the following:

1. Enter your extension in the field Phone number. If you want to use your computer’s sound card,
enter SOUND.

2. Click Call.
3. Pick up the phone as soon as it rings and click the Start button in the Management Console to test

the different profiles.
4. Once you are satisfied with the settings, save them by clicking the Save button.
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5. To disconnect from the server, either hang up the receiver, or click the Hang up button.
To delete a profile, all you need to do is activate it by clicking the corresponding option button, and
then click the Delete profile button.
You can copy a profile by selecting it and clicking the Copy profile button. This will generate a new
profile identical to the selected one. You can give it another name and make a few changes to it.
If you click the Reset profile button, the settings are taken from the user profile. If there are no
settings in the user profile, then the default settings are used (100% speed, 100% pitch). (See the
KCS Clients Administrator’s Manual for detailed information on TC Preferences.)
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TC Printers

TCfW comes with one printer, TC Fax printer.

TC Fax printer attaches files as images,

TC Fax printer also allows you to attach files created in other applications to your messages. And
together with special TC API key words, TC Fax printer allows you to send messages directly from other
applications.

Attaching Files Created in Other Applications
You can attach documents created in other Windows applications, such as spreadsheet or word
processing programs, to your outgoing TCfW messages, provided the TC Fax printer is installed in
Windows.

Follow these steps to attach a file from another application:
1. Make sure the TC Fax printer is installed.
2. Select the TC Fax printer from the Print menu of the Windows application.
3. Complete the regular printing procedure. TCfW’s message window opens.
4. Enter or select the desired recipients.
5. Click Send from the Message menu. This sends your message and automatically returns you to your

Windows application.
If you already have a TCfW message open, you can go to any Windows application and "print" a
document from here to the TC Fax printer installed. In this case the "printout" is attached to the open
message. You can attach any number of documents from any combination of Windows applications
to your message by repeating this procedure.

Faxing from Windows Applications to a New Message
1. Open the Windows application containing the file you want to fax.
2. Open this file.
3. Select TC Fax printer from your application's Print menu.
4. Set the TC Fax printer options as required.
5. Click Print. TCfW starts with your fax attached to the open TC message in the message window.
6. Address this message.
7. Select Send from the Message menu.
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Faxing from Windows Applications to an Existing Message
Note Follow the same steps to send and attach text files and telexes to messages, but select the
corresponding printer.

1. Select Open from the Message menu.
2. In the Open Message window, pick a folder and double-click the entry of the desired message from

the list. Your message appears in the message area of the message window.
3. Place the cursor (in Text mode) in the position you want the "printout" attached.
4. Switch to or start the Windows application containing the document to be attached.
5. Select TC Fax printer and set the options as required.
6. "Print" the desired document to TC Fax printer. TCfW starts.
7. Address your message.
8. Select Send from the Message menu.

Sending Directly from Applications
You can insert API key word commands in messages you create with other Windows applications in order
to send the messages without calling up TCfW. You can also use this feature to send a mass mailing
using your application's mail merge. After you created the message containing the key words, you simply
print it to the TC fax printer.

API Key Word Command Overview
Following keywords are supported:

Keyword Meaning Language File Constant

To Specifies the TO delivery type. TO_TXT

cc Specifies the cc delivery type. CC_TXT

bcc Specifies the bcc delivery type. BCC_TXT

Auth Specifies the Auth delivery type. AUTH_TXT

Subj Subject of the message ENVREF_TXT

Send Sends the message immediately. API_SEND_TXT

Sign Inserts a signature mark for a signature.

API Key Word Rules
• Key words must be enclosed within angle brackets <<>>.
• A key word has to begin immediately after the first set of << (no blank).
• A blank must be inserted between the key word and the following value. For example, <<ToSM>> will

not work. The command must look like this: <<To SM>>, or this: <<To: SM>>.
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• Key words are not case sensitive.
• All key words, with the exception of "Sign", can be written with or without a colon (:).
• You can use the key words <<To>> and <<cc>> any number of times in a single message to send it to

multiple recipients.
• The <<send>> command must be the last key word command in your message. All key word

commands appearing on later pages of the same message, with the exception of <<to>> and <<cc>>,
will cause the TC Fax printer to generate a new message.

• Except for the strings "To" and "cc", key word commands and their angle brackets are automatically
removed from your message upon sending, provided all four angle brackets appear on the same line.

Sign
This API command is interpreted directly by the printer. It is not defined in TCfW. This keyword is hard
wired in the printer and must be <<SIGN>>.

<<Sign>> may be followed by a TCfW user ID. The printer generates one signature mark for each
occurrence of this key word. Two different kinds of signature marks can be generated. One can be used
by any user to insert a signature: <<SIGN>>(any user can sign here).The other can only be used by a
specified user: <<SIGN SM>> (only user SM can sign here).

Removal of API Commands from Output
API commands (<<...>>) are removed from the printer output. API commands are removed from the top
left corner of the opening brackets (<<) to the bottom right of the closing brackets (>>). The area from
which the angle brackets are removed is always rectangle.

Examples:

The complete API command is removed:

<<To: FAX: 6613321>>

Only the angle brackets (<< and >>) are removed:

<<To: FAX: 6613321
>>

Part of the API command is removed:

<<To: FAX: 6613321
>>

Nothing is removed:

<<To: Fax, 6613321
>>

To: and Cc: are not removed. Bcc: and Send are removed:

<<To: FZ
>>
<<Cc: BM
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>>
<<Bcc: SM>>
<<Send>>

Note API commands are removed from fax pages. This means that any background drawings are
also removed. Black text on a gray background leaves a white rectangle where the API commands
were removed. (For an example of how to use API key word commands, see Inserting Signatures with
WinWord)

Output Conversion
The TC Fax supports conversion into different character sets. Conversion is only applied when you select
Output To File.

Supported character sets:
• ANSI (Windows)
• OEM (DOS)

Conversion is applied to all text output including API commands. You can select this conversion in the
Options screen of the printer.

Cut Top Margin
You should enable Cut Top Margin only when you want to send the printed output via a fax channel that
inserts a fax header line.

With Cut Top Margin enabled, TC Fax will cut off the top 9.4 mm of the page.

You should disable Cut Top Margin when you want to send the printed output via a fax channel that
overlays the fax header line.
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Windows Time and Date Formats

In the Regional Settings item of the Windows Control Panel, you can define both a long and a short date
format, and either a 12 hour or 24 hour time format.

Within TCfW, the long date format appears in the following screens:
• Send Options window
• All Search Criteria window in which the date is specified
• Date/Time window

The short date format appears in the following screens:
• All folder windows
• Lines / Statistics window
• Registration window
• Message window (in the Send Options area)
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TCfW Fonts

TCfW to work properly with TCOSS code page 0 or 1 it needs the Windows Courier New font. If this font
is not available, Windows will assign a substitute font. A Substitute font, however, may cause problems.
For instance, Image Mode may not accurately display the way your message will arrive. TCfW will not
generate an error message if the font is not available. Within TCfW, click About in the Help menu and
then select More to see which fonts are currently in use.

For TCfW to work properly with Unicode, it needs a font that supports Unicode (for Example: Arial
Unicode MS). The Unicode font must be configured with TC/Preferences for

1. The Workstation font name
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2. The message header font and the message content font
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Restrictions

Group Address Books: It is possible to add a user to a group that does not exist on TCOSS but the
added user will not be able to use the group address book.

Distribution Lists: Are not resolved correctly in TCfW. As a recipient you can see the name of the
distribution list but you cannot see the other recipients included in that list.
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Glossary

Address:
Includes the service (fax, telex, etc.) and the receiver number. Each service has its own address syntax.
The act of entering or selecting an address in order to send a message.

Answerback:
Information the receiving device returns to the sending device for comparison purposes. If the answerback
received does not match the answerback specified by the sender, Kofax Communication Server
disconnects without sending the message and the sender gets an error message.

Attach:
Imports or inserts an object -file, picture, document-into a message. Kofax Communication Server
supports both binary and image attachments of the same file. Fax receivers will receive only the image
and local users will get both attachments. Local users can view and print image attachments of messages
received even if they don't have the application that originally created the attachment.

Attachment:
Attachments can be overlays, images, binary files, telexes or text files. An attachment can be added to
any message.

Attachment Line:
In Text mode in the Message area of the TCfW Message window, each attachment appears as a single
dotted line, an attachment line. The user switches to Image mode to view the attachment in WYSIWYG.

Auth:
Refers to a particular delivery type whereby the sender must send his/her message through an authorizing
user, who rejects or approves the message for sending.

Authorize:
Approving a message for sending. In TCfW, user profiles determine each user's privileges. Some users
cannot send unauthorized messages, and must therefore send their messages through an authorizing
user, who can either approve them or reject them for sending. To give someone the right to do something.
For example, the Supervisor can authorize users to change their own user profiles.

Auto Login:
Allows the user to start the application automatically, thus bypassing the normal login procedure. There
are two ways to do this one, pre-define your user ID and password; two, use your LAN user ID (requires
no TCfW password because you log in to the LAN before you log in to TCfW).

Bcc:
Blind Carbon Copy. Receivers of this delivery type are kept secret. In other words, To and cc receivers
have no way of knowing about bcc receivers of the same message because bcc receivers do not appear
in the message header with the other receivers.Cc: Carbon Copy. A delivery type whereby the receiver
gets a copy of the message rather than being asked to respond to it.
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Channel Group:
Normally a number of Kofax Communication Server channels responsible for a single service. For
example, all fax lines share the default channel group F

Check Box:
A toggle box. When a check box contains an X, its feature is activated. When it's empty the feature is
deactivated.

Client:
The software a user works with on his/her PC or workstation. The TCfW client allows you to access
TCOSS server features from within other Windows applications. The client can be connected directly or
via a LAN to the TCOSS server.

Clipboard:
Reserved memory used to hold data that has been copied from one application in order to be inserted into
another.

Cost Center:
The group or department in a company responsible for certain users' messaging fees. For example, the
cost center charged for all programmers' outgoing faxes at a company could be listed as the Development
Department.

Cover Sheet:
Defines the first page of a fax message and can be created automatically. Includes the header fields. You
create a cover sheet the same way you create any other message, except that you store it by selecting
SAVE AS from the MESSAGE menu, and then clicking the Save as Cover Sheet check box. Cover
sheets normally consist of an overlay and a text block. The text block contains merge values which are
then substituted by their corresponding header values during sending. To avoid a second page for short
messages the text of a message can be incorporated into the cover sheet.

CPU Key:
The number of licenses acquired is governed by the CPU key. This key normally has an unlimited
expiration date. Upon request, CPU Keys valid until a specific date can be issued for test and demo
installations.

CPU Number:
Each TCOSS server has a unique CPU number used for licensing.

Delivery Notification:
When users are informed that their outgoing messages have reached their receivers. Delivery notifications
can take several forms, such as a beeper beeping, a broadcast message appearing on a user's screen, or
the LED on the telephone blinking. A non-delivery notification informs a user that his/her message could
not be sent properly.

Delivery Type:
Refers to the method of sending. TCfW delivery types include To, cc, bcc and Auth.

DID:
Direct Inward Dialing. This features assigns users their own unique fax extensions, so faxes coming into a
company can go directly and automatically to their ultimate receivers' Inboxes.

118



Kofax Communication Server TCfW Communication Server Client User Manual

Distribution:
This command can be assigned to the Distributor to enable him/her to route messages, which have not
been addressed directly to specific receivers via DID, to their intended receivers. The Distributor clicks
DISTR and enters the intended receivers, and fills in the Subject and From fields. The Distributor cannot
change the message itself. The SEND button finalizes distribution.

Distribution List:
A group of receivers. Can be used for mass mailings.

Distributor:
A TCfW user with special rights and tasks, one of which is the distribution of incoming fax messages to
their ultimate receivers within a company or department. Distribution is only necessary when the users do
not have their own DID extensions.

Drop-Down List:
A selection field which the user clicks to display choices for that field. Same as a pop-up list except that
the list appears below the selection field.

Event:
Kofax Communication Server creates an event when an incoming message arrives (In event), when it
sends a message successfully (Delivery event), when it can't send a message (Non-delivery event), and
when it has a sending copy ready (Sending Copy event). Each event can be used several different ways.
For example, an incoming message can be printed out and cause a LAN Break message.

Fax Information System:
(FIS) Folder containing frequently needed company literature. The FIS folder provides easy storage and
retrieval of such documents. These documents can be leaflets, forms, price lists and any other information
you would like to make widely available. The documents can be accessed via the TCfW client or remotely
from any fax machine. FIS documents can also be attached to any outgoing message originating from the
TCfW client.

Field Description Line:
The gray line above folder lists and below the Select Criteria line, briefly identifying each field in the list.

File Manager:
A Windows program designed to simplify the administration and maintenance of directories and files.

FIS:
See FAX INFORMATION SYSTEM.

Folder:
Used to file a group of messages logically. The user has one message folder on Kofax Communication
Server and can create many more in his/her PC environment.

FIS Folder:
Holds all the information of the Fax Information System (FIS). It can be accessed by all authorized users
both locally and remotely. User access authorization to the FIS folder can be defined in user profiles.

Forward:
This command sends a copy of the message you have selected or opened to one or more receivers.
The original header is moved to the beginning of the message text, allowing you to re-address it and add
comments.
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Header:
The part of the message containing the send options and receiver information.

Header Line:
The small line at the very top of a fax message, containing date, time, sending fax number and sender
name. Can also include number of pages. The fax header line can be suppressed in the Send Options
window.

Icon:
A small, onscreen picture of a function or status. In TCfW, the Toolbar has a number of icons, or buttons,
which you click to execute corresponding functions (e.g., Send icon). The sending status of messages are
also represented by icons in the OUT and Inboxes.

Image:
Images contain fax pages, signatures and other graphical elements. Images are attached to a message
and can be scanned from hardcopy documents, printed from applications or imported from graphics files
(.TIF, .PCX, .BMP, .TCI).

Image Mode:
Displays the message in its final fax format, including the completed cover sheet and overlays.

Inbox:
Shows all messages received by a user. Messages are categorized as unread, read or terminated.

LAN Break Message:
A message that appears on LAN users' screens informing them of an error situation or other event.

Log Entry:
A record of a message in Kofax Communication Server. A log entry may exist for a message even if the
message itself has been deleted.

Login:
The process of entering a user ID and password in order to gain access to a computer system or program.
Automatic login provides a user with system access without requiring him/her to enter a user ID and
password.

Merge Value:
Merge values are codes inserted into cover sheets that retrieve stored values upon sending. For example,
a cover sheet may include the merge value $Name$. This merge value is then converted to Marcus
Schmid, the receiver name, when the message is sent.

Message:
A message may consist of a header, a cover sheet, text and attachments.

Message Folder:
Each user has one Message folder on Kofax Communication Server. You can view a specific group of
folder entries by defining Select Criteria. The selection of folder entries displayed in folder windows can
also be restricted to just the user's own messages. The Supervisor can select any user folder he/she
wants or even view all folders at once.

Object:
In a compound document, an object is an independent block of data, text or graphics created in a
separate application.
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Outbox:
Displays all messages sent by a user. For each receiver of a each message, one entry is created in the
Outbox. The entries are categorized as active, inactive or terminated.

Overlay:
An attached image superimposed on specified pages. You can apply overlays only to cover sheets.

Paintbrush:
A Windows drawing program.

Personal User Folders:
Each user can create, name, and keep an unlimited number of such folders in his/her PC or LAN
environment. These folders have the same appearance in TCfW as Kofax Communication Server’s
folders.

PIN Code:
Each user can have a unique and confidential Personal Identification Number. It is used to access the
user's Inbox and the FIS via fax machines. The PIN code is composed of the numerical user ID and a
numerical password, if defined.

Placeholder:
The insertion point for a signature mark or test key mark in a message. Placeholders are commonly used
in messages that require authorization.

Pop-Up List:
A selection field which the user clicks to display choices for that field. Same as a drop-down list except
that the list appears above the selection field.

Reactivate Button:
Reactivates a selected outgoing message. In other words, send retries are set to 9 again, the old send
order is cancelled and a new one is created. Useful when the receiver's line is busy for long periods.

Receiver:
Any person or entity that can receive a message. Since a receiver can be reached via different services,
he/she has a list of addresses at which he/she can be reached. Preferred services can be put on top of
the services list within a receiver definition. Automatic delivery tries to send to the top one first.

Refresh Button:
This updates the entries in a folder list or other list after the user makes changes, such as terminating
messages in the INBOX.

Reject:
When an authorizing user refuses to authorize a message for sending. He/she rejects the message and
sends it back to its original sender for rewriting.

Reply:
Used to respond to a received message. The To and From fields are swapped and the old header is
copied to the text area of the message. The user adds his/her comments and presses the SEND button.

Route:
The process of finding a way to deliver a message to the receiver. This is normally done fully
automatically. The routing mechanism knows for each service at least one node for further forwarding or
one address for final delivery.
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Scan:
The process of attaching paper based documents (hardcopy) to messages. With TCfW you can scan
hardcopy documents into your messages with either a scanner or a fax machine.

Select Criteria:
Values entered for various fields to specify a range of entries to be displayed in folders lists. With Select
Criteria you can, for example, call up a list of only those messages which arrived between December 5
and 10, 1995.

Send Options:
These determine how a message is sent. Specifically, send options define sending priority, sending time,
cost center, resolution, whether and which cover sheet is used, whether the message contains a fax
header line, whether the sender receives delivery notification, and whether a sending copy is created
upon sending. To view your current send options, click anywhere within the Send Options area.

Send Order:
The TCOSS server receives one or more send orders each time a user clicks the Send icon or SEND
from the FILE Menu. A send order is created for each receiver specified.

Sending Copy:
An exact copy of an outgoing message, printed at the sender's location so he/she can check the
message's appearance and content.

Sendkeys:
Part of the FaxDesk programs. Sendkeys are macros that automate the attaching of images or telexes
created in Windows applications to Mail messages.

Service:
Defines a community of receivers and senders. The subscriber's equipment offers different capabilities for
each service (e.g., fax, telex, X.400).

Session:
The time between login and logoff. A user needs works with the TCOSS server (see also AUTO
LOGIN) during a session. When the user exits the client application, the current session is terminated
automatically.

Short Name:
The user ID on the Kofax Communication Server. Each user has a short name in his/her user profile which
can be entered in the Receiver field for easy addressing and in the Select Criteria window within the Inbox
and Outbox windows to narrow the list of entries displayed.

Status:
Refers to the state or condition of sending of an incoming or outgoing message. You can view the status
of each of your messages in the Inbox and Outbox.

Status Bar:
The bar at the bottom of TCfW windows that displays a brief description of each Toolbar function as it is
being carried out.

Supervisor:
Kofax Communication Server user with special system administration rights and tasks. The Supervisor is
responsible for setting up and maintaining the system and user profiles, as well as assisting the users with
questions and problems.
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System Folder:
The Kofax Communication Server folder containing all TCfW files and accessible to only properly
authorized users.

TCI:
TC Image Format. Kofax Communication Server’s own file format for storing and converting pictures.

TCOSS 7:
TC OPEN SERVER SOFTWARE. This is the software running on the TCOSS server hardware. For its
basic functionality refer to SERVER. For more details refer to our TCOSS 7 System Manual. The software
is tuned for high performance and for open connectivity.

Tech User:
The Kofax Communication Server user with the highest authorization. The Tech User right, combined with
read and write access to all Kofax Communication Server files, gives the Tech user full access to all Kofax
Communication Server files and messages.

Template:
A standard message stored in any Kofax Communication Server folder that contains permanent features
such as the cover sheet, overlays, send options, even receivers. Templates save you the time and trouble
of specifying these message components each time you create a message.

Terminated:
A status of Inbox messages. This means that the user has opened the message and it has been moved to
the archive for eventual deletion. A user can terminate messages manually or automatic termination can
be set in his/her user profile.

Test Key:
In TCfW, the test key feature is used by banks for transferring money. A test key is a code that verifies a
transfer. For example, one user writes the bank transfer and a second, authorizing user inserts the test
key.

Text:
A piece of information entered which can be edited. Text can be edited in Text mode.

Text Mode:
Displays the whole message as text while attachments and form feeds are displayed as one reference line
only. Text can be edited in this mode.

Toolbar:
The bar below the menu bar at the top of various screens which contains the command icons, or buttons,
Click any one of these icons to activate its corresponding function.

TC Fax:
This is a printer driver used for attaching files created in virtually any Windows application as images. By
printing to it from any Windows application, the user opens a new message in TCfW (if no message is
already opened) and attaches the file as image to it. The user then addresses the message by filling in
the header fields and presses SEND. Users can add as many image files as they want from any number
of Windows applications to a single message simply by repeating this procedure with an open TCfW
message.
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Kofax Communication Server Folders:
Folders kept on the TCOSS server, as opposed to personal user folders, which are kept in Windows
directories. These include the Inbox and Outbox, one Message folder per user, the System folder and the
FIS folder.

TC Image Format:
See TCI.

Kofax Communication Server:
The Kofax Communication Server (often referred to in our manuals TCOSS server) offers services to the
clients connected to it. Kofax Communication Server stores all messages of the user folders and manages
address books, scheduling, logging and distribution. It also handles all public lines connected such as fax,
telex, ISDN, X.400, etc. Kofax Communication Server sends and receives messages even if the user's
PC is switched off. In connection with PABX systems, the Kofax Communication Server can be set up to
interpret DID information for automatic distribution of incoming messages. It also manages delivery and
non-delivery notifications of outgoing messages. In addition, It handles printing of incoming messages on
laser printers or fax machines.

Touched:
Once an Inbox message has been opened, viewed, or printed, it gets the status Touched.

User:
Somebody authorized to work with the system. Each user has a user profile and one entry in the System
address book as a receiver.

User Profile:
TCfW users have their own user profiles, which define their rights and restrictions.

WYSIWYG:
Stands for What You See Is What You Get. Image mode in TCfW displays messages in WYSIWYG-as
they look when they are printed or faxed.

Zoom:
To change from a distant view to a more close-up view (zoom in) and vice versa (zoom out).
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